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Abstract 

The analyses of turbulent flow around the ship hulls which include Wigley hull, Kriso container 

ship (KCS), Series 60, HSVA tanker and a catamaran hull are conducted for various Froude 

numbers using a commercial computational fluid dynamics (CFD) code STAR-CCM+. The 

finite volume method (FVM) is employed to discretize the governing equations of fluid flow 

and the SIMPLE (semi-implicit method for pressure linked equations) algorithm is applied to 

get the solution of pressure-velocity coupling equations. The k- turbulence model is chosen to 

give the closure to the Reynolds Averaged Navier Stokes (RANS) equations and the volume 

of fluid (VOF) method is applied to capture the interface between the two phases. Dynamic 

fluid body interaction (DFBI) module is used to simulate the motion of rigid body (ship hull) 

which is unconstrained to sink and trim. A trimmed cell mesher technique is used to produce 

hexahedral cell and prism layer mesher model is applied to resolve the turbulent flow accurately 

near the solid wall of the hulls. 

The present numerical results (wave profile, wave pattern and resistance) obtained from STAR 

CMM+ for each mono hull are compared with those of its available experimental results and 

the agreement is found to be quite satisfactory. The sinkage and trim are calculated only for 

Wigley and KCS hull and are compared with the experiment. The predicted wave pattern is 

composed of transverse and diverging waves and looks very similar to Kelvin wave pattern. 

Moreover, the grid dependency study is carried out for Wigley, KCS and Series 60 hulls and as 

expected the finer are the grids, the better is the accuracy found with a cost of longer computation 

time.  

In case of catamaran, the wave-making resistance of the catamaran hull exhibits broadly similar 

trends to those of the published monohull results as well as the experiment. However, the 

magnitude of the wave elevation of the inner side of the catamaran hull is slightly higher than that 

of the outer side at the first crest of the bow. This difference is mainly due to the wave-interference 

effects.  

Above all, the standard two-equation k- turbulence model with near-wall function is used to 

predict the turbulent flow characteristics which are very close to experimental results and could be 

considered as a powerful tool for analyzing the viscous fluid flow. 



 

viii 

 

Table of Contents 

Certificate of Approval ........................................................................................................ ii 

Certificate of Research....................................................................................................... iii 

Declaration ........................................................................................................................... iv 

Acknowledgement ............................................................................................................... vi 

Abstract ............................................................................................................................... vii 

Table of Contents ............................................................................................................. viii 

List of Figures ...................................................................................................................... xi 

List of Tables...................................................................................................................... xiv 

Nomenclature ...................................................................................................................... xv 

Chapter 1: Introduction .......................................................................................................... 1 

1.1 Background ................................................................................................................. 1 

1.2 Literature Review ........................................................................................................ 1 

1.3 Objectives of the Thesis .............................................................................................. 5 

1.4 Thesis Structure ........................................................................................................... 6 

Chapter 2: Mathematical Modeling of Flow around Ship Hull  ......................................... 7 

2.1 Reynolds Averaged Navier-Stokes Equations ............................................................ 7 

2.2 Turbulence Modeling ................................................................................................ 12 

2.2.1 k   Turbulence Model .................................................................................... 15 

2.3 Near Wall modeling and wall function ..................................................................... 16 

2.4 Free-Surface Flows ................................................................................................... 18 

2.5 Hull Resistance .......................................................................................................... 19 

2.6 Hull Induced Waves .................................................................................................. 20 

2.7 Rigid Body Dynamics ............................................................................................... 21 

2.7.1 Sinkage and Trim ............................................................................................... 22 

Chapter 3: Numerical Methods ............................................................................................ 24 

3.1 Discretization Process ............................................................................................... 24 



 

ix 

 

3.1.1 Geometric and Physical Modeling ..................................................................... 24 

3.1.2 Domain Discretization ....................................................................................... 24 

3.2 Discretization of Governing Equations by FVM ...................................................... 25 

3.3 Solution of Discretized Equations ............................................................................. 29 

3.4 Collocated Grid Arrangement ................................................................................... 29 

3.5 Semi Implicit Method for Pressure –Linked Equation (SIMPLE) ............................ 30 

3.5.1 Solution Algorithm ............................................................................................ 33 

3.6 Convergence .............................................................................................................. 37 

3.7 Grid Dependence and Validation .............................................................................. 38 

3.7.1 Grid Dependence Test........................................................................................ 39 

3.7.2 Validation Procedure ......................................................................................... 40 

Chapter 4: Computational Setup ......................................................................................... 41 

4.1 Co-ordinate System ................................................................................................... 41 

4.2 Boundary Conditions................................................................................................. 41 

4.3 Mesh Generation ....................................................................................................... 43 

4.3.1 Surface Mesh ..................................................................................................... 44 

4.3.2 Volume Mesh ..................................................................................................... 45 

4.4 Physics Modeling ...................................................................................................... 49 

4.4.1 Space Modeling ................................................................................................. 49 

4.4.2 Time Modeling................................................................................................... 49 

4.4.3 Materials Modeling ............................................................................................ 49 

4.4.4 Multiphase Flow Modeling ................................................................................ 50 

4.4.5 VOF Waves ........................................................................................................ 51 

4.4.6 Turbulence Modeling ......................................................................................... 52 

4.4.7 Wall Treatment Modeling .................................................................................. 53 

4.5 DFBI Modeling ......................................................................................................... 55 

4.6 Solver Setting ............................................................................................................ 55 



 

x 

 

Chapter 5: Results and Discussions...................................................................................... 57 

5.1 Wigley Hull ............................................................................................................... 57 

5.2 KCS Hull ................................................................................................................... 70 

5.3 Series 60 Hull ............................................................................................................ 82 

5.4 HSVA Tanker ............................................................................................................ 88 

5.5 Catamaran Hull ......................................................................................................... 91 

Chapter 6: Conclusions ......................................................................................................... 96 

References ............................................................................................................................... 97 

Appendix A ............................................................................................................................... I 

Derivation of Turbulent Kinetic Energy, k  ......................................................................... I 

Appendix B ............................................................................................................................... I 

Numerical Scheme to predict Body Motion ........................................................................... I 

Appendix C .......................................................................................................................... VIII 

Residual Convergence ....................................................................................................... VIII 

Appendix D .............................................................................................................................. X 

Time History of Resistance ................................................................................................... X 

Appendix E .......................................................................................................................... XIII 

Outline of Simulation Setup .............................................................................................. XIII 

 



 

xi 

 

List of Figures 

Fig. 2.1: Boundary layer velocity profile [29] -------------------------------------------------------16 

Fig. 2.2: The bow and stern wave systems [32] ------------------------------------------------------20 

Fig. 2.3: Representation of Ship motion with 6 DOF [30] -----------------------------------------21 

Fig. 3.1: A three dimensional control volume with CVs face [40] --------------------------------25 

Fig. 3.2: Illustration of an implicit method [25] -----------------------------------------------------28 

Fig. 3.3: Collocated grid arrangement of velocity componenets [25] ----------------------------30 

Fig. 3.4: Nodal indexing of elemental cell in three dimensions [25] -----------------------------30 

Fig. 3.5: Solution algorithm of Transient SIMPLE Scheme [25, 36] -----------------------------36 

Fig. 4.1: Coordinate system used in this present study ---------------------------------------------41 

Fig. 4.2: Computational domain and its boundary conditions -------------------------------------42 

Fig. 4.3: Surface mesh of the computational domain -----------------------------------------------44 

Fig. 4.4: Surface mesh of the KCS hull ---------------------------------------------------------------45 

Fig. 4.5: Finite volume mesh applied to the domain and hull model -----------------------------46 

Fig. 4.6: Refined mesh scene at the free surface -----------------------------------------------------47 

Fig. 4.7: Mesh applied at the bow and stern regions ------------------------------------------------47 

Fig. 4.8: Generated prism layers with the core mesh ------------------------------------------------48 

Fig. 4.9: Iso surface generated by multiphase modeling --------------------------------------------50 

Fig. 4.10: Free surface at initialization stage of simulation. ---------------------------------------51 

Fig. 5.1: Computational Domain of Wigley Hull ----------------------------------------------------58 

Fig. 5.2: Mesh structure for flow computation domain ---------------------------------------------58 

Fig. 5.3: Grid distribution on the surface of Wigley hull -------------------------------------------59 

Fig. 5.4: Comparison of total resistance coefficient for Wigley hull.-----------------------------60 

Fig. 5.5: Comparison of sinkage and trim for Wigley hull -----------------------------------------61 

Fig. 5.6: Pressure distribution over the surface of Wigley hull ------------------------------------62 

Fig. 5.7: Wave profile along the Wigley mono hull with experimental results. -----------------63 

Fig. 5.8: Kelvin Wave pattern at different Froude numbers for Wigley hull --------------------64 

Fig. 5.9: Kelvin Wave pattern comparison for Wigley hull ----------------------------------------65 

Fig. 5.10: Grid dependency on wave profile of Wigley hull ---------------------------------------69 

Fig. 5.11: Computational Domain of KCS hull ------------------------------------------------------71 

Fig. 5.12: Mesh structure of flow computation domain --------------------------------------------71 

Fig. 5.13: Grid Distribution on the KCS hull ---------------------------------------------------------72 

Fig. 5.14: Convergence history of Resistance of KCS hull at Fn = 0.26 -------------------------72 

file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491829
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491830
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491831
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491832
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491833
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491834
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491835
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491836
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491837
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491838
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491839
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491840
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491842
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491844
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491846
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491848
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491850
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491855
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491856
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491857
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491858


 

xii 

 

Fig. 5.15: Comparison of total resistance coefficients of KCS hull. ------------------------------73 

Fig. 5.16: Comparison of (a) Sinkage and (b) Trim for KCS hull --------------------------------74 

Fig. 5.17: Pressure distribution over the surface of Wigley hull ----------------------------------76 

Fig. 5.18: Kelvin Wave pattern for KCS hull at different Froude numbers----------------------77 

Fig. 5.19: Comparison of Kelvin wave pattern of KCS hull between CFD (bottom) and EFD 

(top) --------------------------------------------------------------------------------------------------------78 

Fig. 5.20: Wave profile along the KCS hull ----------------------------------------------------------78 

Fig. 5.21: Transverse wave cut of KCS hull ----------------------------------------------------------79 

Fig. 5.22: Grid dependency study of wave profile for KCS hull ----------------------------------81 

Fig. 5.23: Grid distribution on the surface of Series 60 hull ---------------------------------------82 

Fig. 5.24: Mesh structure for flow computation of Series 60 hull ---------------------------------83 

Fig. 5.25: Comparison of total resistance coefficient of Series 60 hull---------------------------83 

Fig. 5.26: Wave profile along the Series 60 hull at different Froude numbers ------------------84 

Fig. 5.27: Kelvin Wave pattern for Series 60 hull at different Froude numbers ----------------85 

Fig. 5.28: Comparison of wave pattern between Huang[57] (Left) and present study (Right)86 

Fig. 5.29: Grid dependency on wave profile for Series 60 hull ------------------------------------87 

Fig. 5.30: Surface mesh on the HSVA Tanker -------------------------------------------------------88 

Fig. 5.31: Computational domain of HSVA Tanker ------------------------------------------------89 

Fig. 5.32: Mesh structure for flow computation of HSVA Tanker --------------------------------89 

Fig. 5.33: Comparison of total resistance coefficient for HSVA tanker --------------------------90 

Fig. 5.34: Wave profile along the HSVA hull at different Froude numbers ---------------------90 

Fig. 5.35: Computational domain of the wigley catamaran hull -----------------------------------91 

Fig. 5.36: Volume mesh with refinement at the hull separation and wake region --------------92 

Fig. 5.37: Wave resistance coefficient comparison of Wigley catamaran hull ------------------92 

Fig. 5.38: Kelvin Wave pattern at different Froude numbers of Wigley catamaran (s/L= 0.4)

 --------------------------------------------------------------------------------------------------------------93 

Fig. 5.39: Wave profile along the Wigley catamaran hull (s/L= 0.4) -----------------------------94 

Fig. 5.40: Pressure distribution on the surface of Catamaran hull --------------------------------95 

Fig. C.1: Residual convergence of Wigley hull --------------------------------------------------- VIII 

Fig. C.2: Residual convergence of KCS hull ------------------------------------------------------ VIII 

Fig. C.3: Residual convergence of Series 60 hull ------------------------------------------------ VIII 

Fig. C.4: Residual convergence of HSVA tanker hull ------------------------------------------- VIII 

Fig. C.5: Residual convergence of Wigley catamaran hull -------------------------------------- VIII 

Fig. D.1: Time history of Total, Residual and Frictional Resistance of Wigley hull ----------- X 

file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491861
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491863
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491865
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491865
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491868
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491869
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491871
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491875
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491876
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491879
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491883
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491886
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491887
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491888
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491889
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491890
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491891
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491892


 

xiii 

 

Fig. D.2: Time history of Total, Residual and Frictional Resistance of KCS hull -------------- X 

Fig. D.3: Time history of Total Resistance of Series 60 hull ------------------------------------- XI 

Fig. D.4: Time history of Total, Residual and Frictional Resistance of Catamaran hull ----- XII 

 

 

file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491893
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491894
file:///D:/Msc%20Thesis/Thesis%20Book/MSc/MSc%20Thesis%20Book%20(26%20July).docx%23_Toc78491895


 

xiv 

 

List of Tables  

Table 4.1: Overall thickness of a prism layer for KCS ............................................................ 48 

Table 4.2: Material properties for multiphase modeling ......................................................... 50 

Table 5.1: Main Particulars of Wigley Hull............................................................................. 57 

Table 5.2: Relative error analysis of resistance coefficient for Wigley hull ........................... 61 

Table 5.3: Grid properties for CT, CF, and CW ........................................................................ 66 

Table 5.4: Grid convergence study of CT, CF, and CW for Wigley hull .................................. 66 

Table 5.5: Verification of CT, CF, and CW for Wigley hull .................................................... 68 

Table 5.6: Validation of CT, CF, and CW for Wigley hull ....................................................... 69 

Table 5.7: Grid convergence study of wave profile for Wigley hull ....................................... 70 

Table 5.8: Verification and validation of wave profile for Wigley hull .................................. 70 

Table 5.9: Main particulars of KCS hull form ......................................................................... 70 

Table 5.10: Relative error analysis of total resistance coefficient for KCS hull ..................... 74 

Table 5.11: Relative error analysis of Sinkage and Trim for KCS hull ................................... 75 

Table 5.12: Grid properties for CT, Sinkage, and Trim ........................................................... 79 

Table 5.13: Grid convergence study for CT, Sinkage, and trim for KCS hull ......................... 80 

Table 5.14: Verification of CT, Sinkage, and trim for KCS hull ............................................. 80 

Table 5.15: Validation of CT, Sinkage, and trim for KCS hull ................................................ 81 

Table 5.16: Main Particulars of Series 60 Hull........................................................................ 82 

Table 5.17: Grid properties for CT at Fn = 0.30 ...................................................................... 86 

Table 5.18: Grid convergence study for CT Series 60 hull ...................................................... 86 

Table 5.19: Verification of CT for Series 60 hull .................................................................... 87 

Table 5.20: Validation of CT for Series 60 hull ....................................................................... 87 

Table 5.21: Main Particulars of HSVA.................................................................................... 88 



 

xv 

 

Nomenclature 

Acronyms 

Symbol Description 

CFD Computational Fluid Dynamics 

CDS Central Differencing Scheme 

CVs Control Volumes 

DFBI Dynamic Fluid Body Interaction 

DNS Direct Numerical Simulation 

DOF Degree of Freedom 

EFD Experimental Fluid Dynamics 

FVM Finite Volume Method 

GCI Grid Convergence Index 

HSVA HamburgischeSchiffbauVersuchsanstalt / Hamburg Ship Model Basin 

ITTC International Towing Tank Conference 

KCS KRISO Container Ship 

KRISO Korean Institute of Ships and Ocean Engineering 

LES Large Eddy Simulation 

QUICK Quadratic Upstream Interpolation for Convective Kinematics 

RANSE Reynolds Averaged Navier Stokes Equations 

RE Richardson Extrapolation 

SIMPLE Semi Implicit Method for Pressure Linked Equations 

SST Shear Stress Transport 

VOF Volume of Fluid 

V&V Verification and Validation 

 

Roman Symbols 

Symbol Description Unit 

AP  Aft Perpendicular    

B  Beam of the Ship  m  

BC  Block Coefficient    

FC  Frictional Resistance     



 

xvi 

 

OC  Courant Number    

PC  Pressure Coefficient    

RC  Residuary Coefficient    

TC  Total Resistance Coefficient    

WC  Wave Resistance Coefficient    

C  Eddy Viscosity Coefficient    

1 2,C C 
 Constant in Turbulence Model    

D  Depth  m  

FP  Forward Perpendicular    

nF  Froude Number    

g  Gravitational Acceleration   2ms    

, ,xx yy zzI I I  Moment of Inertia 2kgm    

, ,xy yz zxI I I  Product of Inertia 2kgm    

J  Jacobian Transformation    

k  Turbulent Kinetic Energy 2 2m s    

L  Characteristic Length  m  

PPL  Length Between Perpendiculars  m  

p  Pressure  Pa  

p  Average Pressure  Pa  

p  Fluctuating Pressure  Pa  

Q  Production of Turbulent Kinetic Energy    

ir  Grid Refinement Ration    

TR  Total Resistance  N  

FR  Frictional Resistance  N  

RR  Residuary Resistance  N  



 

xvii 

 

kR  Convergence Ratio    

nR  Reynolds Number    

wetS  Hull Wetted Surface Area 2m    

S  Simulation Result    

S  Source Term    

T  Draft  m  

t  Time  sec  

U  Velocity Vector  / , / , /m s m s m s  

u  Velocity Component  /m s  

u
 Dimensionless Velocity    

*u  Friction Velocity  /m s  

SNU  Numerical Uncertainty    

IU  Iterative Uncertainty    

GU  Grid Uncertainty    

y  Distance to Wall  m  

y  Non-Dimensional Wall Distance    

 

Greek Symbols 

Symbol Description Unit 

  Constant    

  Displacement  N  

t  Time Step  sec  

, ,x y z    Grid Spacing  m  

  Dissipation Rate of Turbulent Kinetic 

Energy 

2 3/m s    

  Dynamic Viscosity 2Nsm    

t  Turbulent Viscosity  2Nsm    



 

xviii 

 

  Kinematic Viscosity 2 /m s    

  Fluid Density 3/kg m    

w  Wall Shear Stress  Pa  

  Transport Variable    

  Von Karman Constant    

ij  Viscous Stress Term  Pa  

  Diffusion Coefficient    

  Sinkage  m  

  Roll Angle  deg  

  Trim Angle  deg  

  Yaw Angle  deg  

  Boundary Layer Thickness  m  

RE  Grid Discretization Error    



 

1 

 

1 Chapter 1 

Introduction 

1.1 Background 

The recent advances in Computational Fluid Dynamics (CFD) for incompressible flow are 

gradually proving to be invaluable asset for design and analysis of ship, submarines, 

underwater missiles, low speed transport aircrafts and a wide variety of equipment design in 

process industry. Accurate prediction of turbulent flow is of great practical interest in the 

overall performance of ship hull to be designed. The ship hull advances in water continuously 

incorporate with air and water and a free surface generated between these two phases. The 

surface wave due to the existence of this free surface, the presence of turbulent boundary layers 

are very common characteristics for which the flow around the ship hull is being extremely 

complicated and the hydrodynamic behaviors of a ship hull are significantly related to the 

surrounding flows [1].  Modeling the flow taking the turbulence effects into account to evaluate 

the hydrodynamic performance of the concepts is always being a prioritize research area in the 

ship engineering and academia.  

Towing tank test is performed to analyze the hydrodynamic performance like resistance, 

sinkage, trim, wave profile etc. at corresponding speeds, which are crucial to establishing 

reliable propulsive power from the ship design viewpoint and this test method is more accurate 

and reliable. But there are some challenging areas like the readily available towing tank and 

the cost associated with the towing test are common. The towing tank flow characteristics differ 

from full scale and also prediction full-scale performance from towing tank at equivalent 

Froude number is challenging. The rapid technological advances of CFD resources are 

implemented for the development of high-performance hull forms under the realistic rough 

environment conditions. Numerical predictions also assure a new era of design and 

optimization by providing a great deal of information on the flow with considerably fewer 

resources and time [2]. These achievability motivates to use the CFD tool to investigate the 

complex flow characteristics which govern a lot of key factors over the body like resistance, 

sea keeping analysis. 

Providing a great detail of flow fields, the CFD tool solves the viscous flow problems by 

offering both model ship and full scale results. Several viscous flow approximations in ship 

engineering field such as Direct Numerical Simulation (DNS), Large Eddy Simulation (LES), 
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and Reynolds Averaged Navier Stokes (RANS) have emerged with increasing computing 

power. Among these but not limited to, for the analyses of the turbulent flow over the ship hull, 

the RANS approximation is the most computationally efficient and a common technique for 

evaluating the ship hydrodynamic behaviors. To ensure the quality of the applied 

approximation method, a systematic approach like the comparison between computation and 

experiment could be a favorable way [2]. 

The study is focused on the investigation of the turbulent flow around the ship hulls including 

the mono and multi hulls (Wigley, KCS, Series 60, HSVA Tanker and Catamaran hulls). 

Finite volume method (FVM) based commercial CFD software STAR-CCM+ is used to 

perform the whole simulation and SIMPLE (semi-implicit method for pressure linked 

equations) algorithm is applied to get the solution of pressure-velocity coupling equations. 𝑘 −

𝜀 two equations turbulence model is used to give the closure of Reynolds Averaged Navier 

Stokes (RANS) equation to extract the velocity and pressure fields. Volume of Fluid (VOF) 

multiphase model is implemented to determine the position of free surface between air and 

water phases. 

1.2 Literature Review  

The understanding of the physics of fluid turbulence is far from complete and Reynolds 

Averaged Navier Stokes (RANS) methodology coupled to statistical turbulence model is often 

very useful and reliable for computation of statistically stationary turbulent flows. Modeling 

the turbulence in order to close the RANS equations has been paid much attention. However, 

there is no single turbulence model which can predict reliably all kinds of turbulent flows. 

Every model have its own pros and cons. The 𝒌 − 𝜺 model [3-4] is the most widely known and 

extensively used two-equation eddy viscosity model. In case free shear layer flows with 

relatively small pressure gradients, this model has given good results. The transport equations 

for this model are solved to get two scalar properties: the turbulent kinetic energy, k and the 

dissipation rate (𝜀) of the turbulent kinetic energy. To define the eddy viscosity function 

another two equation 𝒌 − 𝝎 model [3-4] was originated in parallel with the prior turbulence 

model. This model shows a good settlement with experiment in the logarithmic region of the 

boundary layer profile for trivial adverse pressure gradient flows. However, it is difficult to 

implement enough control over the local free stream turbulence to avoid small free stream 

dissipation rate of this model, 𝜔  in the complex Naiver-Stokes computation and consequently, 

haziness arise in the predicted results. When flow separation is expected, the shear stress 
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transport (SST) model [5] modify the turbulent eddy viscosity function to improve the 

prediction of separated flows. A serious deficiency occurs in two equation models: under 

predict the retardation and separation of the boundary layer due to adverse pressure gradients. 

This deficiency can be mitigated by modeling the transport of the shear stress as being 

proportional to that of the turbulent kinetic energy. The One equation turbulence [6] 

(Spalarts-Allamaras) model provide a simpler alternative to two equation turbulence models. 

For 2-D mixing layer, wake flow, flat boundary layers this model gives reasonably good 

predictions [7]. 

Azcueta [8] computed turbulent free-surface flows around ships and floating bodies where for 

modeling turbulence, the standard k-epsilon model with wall function was applied. To locate 

the free surface, the volume of fluid (VOF), an interface-capturing method was used. It was 

found that total resistance for the Series-60 model in free condition was 10% larger than in 

fixed condition. 

Adjali et al.  [9] numerically simulated free surface water waves generated by moving bodies. 

Turbulence was modeled using the shear stress k-omega SST model and the free surface motion 

was simulated by volume of fluid technique. Numerically obtained results were compared well 

with the experimental data. 

Tarafder and Mursaline [10] simulated two dimensional steady viscous flow past the circular 

and circular cylinder at low Reynolds numbers. To reduce the computational cost, a simplified 

pressure correction was extracted and appropriate under-relaxation factors were used. The 

solution of the governing equations of the flow was carried out using SIMPLE algorithm. From 

the numerical results of bubble length, separation angle, total drag in case of square and circular 

cylinders, it was found that square shaped cylinder is more bluff than a circular one. 

Tarafder and Mursaline [11] simulated the turbulent flow around two-dimensional bodies using 

the finite volume method with non-orthogonal body fitted grid. The k- turbulence model and 

wall functions were used to bridge the solution variables at the near wall cells and the 

corresponding quantities on the wall. The solution was carried out using the SIMPLE algorithm 

with a simplified pressure correction equation for collocated arrangement for scalar and vector 

variables. 

Zhao et al.  [1] studied viscous flow around the hull with free surface solving the Reynolds-

Averaged Navier-Stokes (RANS) equations. The agreement between numerical and 
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experimental results indicated that the CFD model is capable to simulate the viscous flows 

around the ship hulls with an acceptable accuracy level. 

Pranzitelli et al.  [12] simulated free surface flow around a semi-displacing motor yacht 

advancing steadily in calm water. The volume of fluid method (VOF) was implemented in 

Reynolds-Averaged Navier-Stokes (RANS) equations and this VOF method correctly 

predicted both the free surface shape and the total resistance. 

Perez et al.  [13] validated resistance and wave profile at six Froude numbers with the 

application of CFD code ANSYS-CFX 11.0. The study showed a good agreement for 

resistance, but the wave profiles along the hull were not in satisfactory level. To determine the 

suitable turbulence model for the highest and lowest Froude numbers, a statistical hypothesis 

test was conducted. For the lowest Froude number, 0.25, better agreement in resistance 

prediction was found using 𝑘 − 𝜀 model while for the highest Froude number, 0.408, 

satisfactory result was found applying the 𝑘 − 𝜔 model followed by the SST. 

Karim et al. [14] studied effect of free surface waves and wave induced separation on a 3D 

surface piercing rudder with NACA 0012, 0018, 0024 airfoils using CFD code ANSYS Fluent. 

The SST 𝑘 − 𝜔 turbulence model captured the boundary layer and volume of fluid (VOF) 

method tracked the free surface successfully. The research indicated that at the higher Froude 

number wave patterns are dependent on the Froude number rather than thickness of the body. 

Karim and Naz [15] investigated the viscous flow the ship hull while the propeller action was 

taken into consideration. Firstly, the bare hull condition was focused to predict the free surface 

elevation and the resistance components. A zonal approach with the solver was applied at the 

three zones: “potential flow solver”, “boundary layer solver” and “Navier-Stokes solver” in the 

region outside the boundary layer and wake, the thin boundary layer near to the ship hull, and 

wake region respectively.  

Ozdemir et al.  [16] performed a CFD analysis to simulate free surface flow around the KCS 

hull using 𝑘 − 𝜀  turbulence model where the RANS equations and non-linear free surface 

boundary conditions were discretized with the aid of finite volume scheme. To create the 

solution domain, an unstructured mesh was generated. The calculated total resistance 

coefficient for the finer grid was satisfactory with the margin of 2.77% of the experimental one 

and Residual resistance coefficient was calculated with an error of 7.45% for fine grid. The 

𝑘 − 𝜀 turbulence model provided good results in fully turbulent free surface flows around the 

ships.   
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Ahmed [17] used RANSE code CFX to simulate the incompressible turbulent free surface flow 

around the complex hull form DTMB 5415 at two different speeds. The standard 𝑘 − 𝜀 model 

was used in the CFX model and to build the hybrid grid for the RANSE code solver, a grid 

generator ICEM CFD was applied. In the computational grid generation, the domain was 

meshed with structured hexahedral grid while the hull surface was meshed with unstructured 

tetrahedral grid.  

Wang and Walter [18] performed simulations of marine propeller using a transition-sensitive 

turbulence model to better resolve the propeller flow characteristics. Fully turbulent flow 

simulations were also performed for comparison purposes at various propeller load conditions. 

Results showed that the applied transition-sensitive turbulence model is better able to resolve 

blade-surface stresses, flow separations, and tip-vortex originations, and consequently, 

improve the prediction accuracy in propeller performance, especially under high-load 

conditions. 

Karim et al. [19] simulated the surface wave generated by flow around submerged hydrofoils 

at different depth to compute wave amplitude, lift and drag.  Volume of fluid (VOF) technique 

was used to determine the free surface effect of the water and the Semi Implicit Method for 

Pressure Linked Equations-Consistent (SIMPLEC) was implemented for pressure-velocity 

coupling. The discretization of momentum, volume fraction, turbulent kinetic energy, and 

turbulent dissipation rate was carried out by second order upwind scheme.  

Chao-bang and Wen-cai [20] calculated the resistance of a high-speed displacement ship taking 

the effect of sinkage and trim and viscosity of fluid into account. A free surface flow field was 

evaluated by solving Reynolds averaged Navier-Stokes (RANS) equations with volume of fluid 

(VOF) method. The sinkage and trim were computed by equating the vertical force and pitching 

moment to the hydrostatic restoring force and moment. 

Tu et al.  [21] predicted ship resistance, sinkage and trim in calm water by using unsteady 

RANS method. Grid convergence study was also carried out to determine the grid effect on the 

results. The resistance coefficient was well agreed with experiment, but the obtained trim and 

sinkage differed more from the experiment. 

In the field of naval architecture, one of the major challenges to extract the resistance 

components of catamaran hull is the effect of complex wave interference between the two demi 

hulls. The selection of the hull form, separation between the mono hulls are consideration factor 

in predicting the hydrodynamic behaviors including resistance, sinkage, and trim. Insel and 
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Molland  [22] investigated the total resistance components, trim, sinkage, and wave pattern of 

mathematically defined Wigley hull form for a wide range of Froude numbers taking different 

hull separation to length ratios.  These results are extensively used as experimental reference 

data for many numerical studies.  

To clarify the characteristics of flow field around the high speed catamaran in calm water, a 

numerical study was conducted by Kwag [23]. Free surface with nonlinearity condition in 

Navier-Stokes solver was applied and the grid generation was based on Marker and Cell 

method in the computation. The extracted results depicted that at the low hull separation value, 

the wave interference becomes stronger and at the high hull separation, the wave interference 

almost diminish that looks like to the wave pattern of the mono hull. Wave resistance 

coefficient showed a good agreement with experimental data. 

Tarafder and Suzuki [24] solved a non-linear free surface flow problem for Wigley catamaran 

hull using potential based boundary element method. Mono hulls were considered as lifting 

body due to the difference between the interior flow and exterior flow of each mono hull. At 

the bow side, the inner region wave profile has been found higher than the outer region wave 

profile. This was resulted from the wave interference between the hulls. The wave resistance 

coefficients were calculated for three different hull separation to length ratios (s/L = 0.2, 0.3, 

0.4) at the Froude numbers ranging 0.2-1.0 and found acceptable trends to those published 

literatures. 

1.3 Objectives of the Thesis 

The objectives of the present research are as follows: 

i. To compute the resistance of different types of mono hulls (Wigley, Series 60, KCS 

and HSVA tanker) and multi-hulls (Catamaran) using STAR-CCM+. 

ii. To compute the sinkage, trim and wave pattern around the aforesaid hulls. 

iii. To validate the computed results with the available experimental results. 

iv. To study the uncertainty of the computed results. 
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1.4 Thesis Structure 

The thesis is organized in the following way. There are total 6 (Six) chapters in this thesis. The 

current chapter presents a general background providing the motivation, the review some of 

the published literatures, and the objectives of the present work.  

In the chapter 2, a complete set of governing equations for modeling the fluid flow, turbulence 

modeling, and the rigid body dynamics are explained. 

In the chapter 3, a general transport equation is developed and a numerical scheme is applied 

to discretize that equation. The solution algorithm for the discretized equation is discussed in 

details. In the same chapter, total verification and validation (V&V) studies are mentioned. 

In the chapter 4, the total simulation set up in the STAR-CCM+ are described.  The set-up 

processes started from the defining the coordinate system, computational domain creation, 

defining the boundary conditions, mesh generation, physics modeling and the solver setting. 

In the chapter 5, results of total resistance coefficients, wave profile, and wave patterns for 

four mono hulls (Wigley, KCS, Series 60, and HSVA tanker) are presented and compared with 

those of its available experimental results. Sinkage and trim are calculated only for the Wigley 

and KCS hulls and presented in this chapter as well. Moreover, verification and validation 

(V&V) studies are performed in case of Wigley, KCS and Series 60 hull which are also 

discussed in the chapter 5. The wave making resistance for the Wigley catamaran hull, inner 

and outer wave profile along the hull are extracted and presented in this chapter. 

Finally, in the chapter 6, a conclusion of the whole thesis is offered. 
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2 Chapter 2 

Mathematical Modeling of Flow around Ship Hull 

 

Computational Fluid Dynamics (CFD) is the branch of fluid dynamics providing a cost-

effective means of simulating real flows by the numerical solution of the governing equations. 

The governing equations [25] of 3-dimensinonal turbulent flows for an incompressible fluid 

around a ship can be represented by the continuity and momentum equations as follows: 

0
u v w

x y z

  
  

  
 (2.1) 

2 2 2

2 2 2
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Equations (2.2) to (2.4) are called the Navier Stokes equations, where  and  are the density 

and the kinematic viscosity of the fluid. p is the pressure exerted by the fluid and u, v, w are 

the instantaneous velocity components along the x, y and z directions respectively. 

In the fluid motion, the inertia forces are sufficiently large to amplify the disturbance and a 

transition to turbulence occurs at the high Reynolds number. The velocity and all other flow 

properties are varying in a random and chaotic way. The random nature of flow and the inherent 

non-linearity in the Navier-Stokes (NS) equations precludes an analytical description of flow 

computation. 

2.1 Reynolds Averaged Navier-Stokes Equations 

Turbulence consists of random fluctuation of various flow properties and for best purposes, a 

procedure introduced by Reynolds [26] that all quantities are expressed as sum of mean 

fluctuating parts. This is called Reynolds decomposition. 

                                                                                                                                 (2.5) 
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where   and   are the mean and fluctuating terms respectively.  The mean or time averaged 

 is defined by, 

0

1
t

dt
t

 



   (2.6) 

The time average of the mean value 

0

1
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The time average of the fluctuating term 
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Other time averaging term for variable   and   can be written as follows: 
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t
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Decomposition the flow properties in mean and fluctuating terms give: 

u u u

v v v

w w w

p p p
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 
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                                                                                                                          (2.14) 

Substituting these decomposition terms into the continuity and momentum equations and 

following the time averaging properties, the Reynolds form of continuity equation becomes 

           0u u v v w w
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             (2.15) 
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Reynolds form of momentum equation for x-component, 
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Similarly the y and z components 

       v v vu v u vv v v vw v w
t x y z
       

   
             

   
 

 

                 
   

 

yx yy

zy

p
u v v u v u u v v v v v

y x y

v w w v v w
z

       

   

  
                      

  


         



 (2.24) 

       w w wu w u wv w v ww w w
t x y z
       

   
             

   
 

 

         
   

 

zx zy

zz

p
w w w u w u w v v w w v

w x y

w w w w w w
z

       

   

  
                      

  


         



 (2.25) 

These Equations (2.23), (2.24), and (2.25) are called Reynolds Averaged Navier-Stokes 

equation for unsteady, compressible flows 

Where, 

2
2

3
xx

u u v w

x x y z
  

    
    

    
 (2.26) 

2
2

3
yy

u u v w

y x y z
  

    
    

    
 (2.27) 

2
2

3
zz

u u v w

z x y z
  

    
    

    
 (2.28) 

xy yx

u v

y x
  

  
   

  
 (2.29) 

xz zx

u w

z x
  

  
   

  
 (2.30) 

yz zy

v w

z y
  

  
   

  
 (2.31) 
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For unsteady and incompressible flow the continuity and momentum equation becomes, 

0
u v w

x y z

  
  

    

(2.32) 

x- Component of momentum equation 

          u u u u u u u u v v u u w w
t x y z


    

                
    

 

       

   

2p p u u u u v v
x x x y y x

u u w w
z z x

 



        
                       

     
          

                                        (2.33) 

     
u

uu u u uv u v uw u w
t x y z


    

           
    

 

2
p u u v u w

x x x y y x z z x
  

                
             

                   
 

xx yx zxp

x x y z

     
    

   
                                                                                               (2.34) 

u uu uv uw

t x y z

    

   
    

     xx yx zx

p
u u u v u w

x x y z
     

   
            

   
 (2.35) 

y- Component of momentum equation 

     xy yy zy

v vu vv vw p
u v v v v w

t x y z y x y z
      
        

                
        

 (2.36) 

z- Component of momentum equation 

     xz yz zz

w wu wv ww p
u w v w w w

t x y z z x y z
      
        

                
        

 (2.37) 

These equations (2.35), (2.36), and (2.37) are called Reynolds Averaged Navier-Stokes 

equation for unsteady incompressible flow.  

Where, 

2
u

xx
x

 





 (2.38) 
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2
u

yy
y

 





 (2.39) 

2
u

zz
z

 





 (2.40) 

u v
xy yx

y x
  

 
  
 

 
  

 
 (2.41) 

u w
xz zx

z x
  

 
 
 

 
  

 
 (2.42) 

v w
yz zy

z y
  

 
  
 

 
  

 
 (2.43) 

Here all the instantaneous quantities are replaced by their corresponding time-averaged 

quantities. But there are appearances of new additional six quantities (Reynolds stress tensor) 

in the equation and also there are no new equations. In general, there are already four unknown 

mean-flow properties i.e. pressure and three velocity components and now along with six new 

unknowns, hence in total there are ten unknowns. And, unfortunately the system has only four 

equations (Continuity and three momentum equations). So, it is needed to find enough 

equations to close the system. 

2.2 Turbulence Modeling 

Modeling the turbulence is referred as the process of finding a closure to the Reynolds 

Averaged Navier-Stokes equations. The additional Reynolds stress terms represent the effect 

the of the fluctuating velocity components of the mean velocity field. To modeling the 

turbulence, a more popular approach called eddy-viscosity or turbulent viscosity will be 

presented here. In this closure approach, differential equations or transport equations are 

derived for each of the Reynolds stresses.  

Boussinesq [27] suggested that the apparent turbulent shearing stress might be related to the 

rate of mean strain through an apparent scalar turbulent or eddy viscosity. For Reynolds stress 

tensor, the Boussinesq hypotheses, 

2
2

3
t

u
u u k

x
  


   


 (2.44) 

2
2

3
t

u
v v k

y
  


   


 (2.45) 

2
2

3
t

u
w w k

z
  


   


 (2.46) 
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t

u v
u v v u

y x
  

  
        

  

 (2.47) 

t

u w
u w w u

z x
  

  
        

  

 (2.48) 

t

v w
v w w v

z y
  

  
        

  

 (2.49) 

Where t is turbulent viscosity and k is called the turbulent kinetic energy and expressed as 

The hypothesis provided by Boussinesq, replaces the Reynolds stress when put into the 

momentum equations but it generates two new unknowns k  and t . Both k  and t vary point 

to point in the flow.  

Substituting Equations (2.44), (2.45), (2.46), (2.47), (2.48), and (2.49) into the Equations 

(2.35), (2.36), and (2.37) the Reynolds Averaged momentum equation of x-component 

becomes, 

u uu uv uw

t x y z

   
  

   
     

1 1 1 1
xx yx zx

p
u u u v u w

x x y z
     

   

   
            

   
 

 
1 1 1 1

2
p u u v u w

u u u v u w
x x y zx y x z x

     
   

        
                      

       
              

       
                 (2.51) 

Simplifying the right hand side of the above equation: 

1 1 2
2 2 2

3
t

u u u
u u k

x x x x x
    

 

       
       

       

 

                                    
1 2

2
3

t

u
k

x x x
  



     
     
     

                                             (2.52) 

1 1u v u w
u v u w

y y x z z x
   

 

           
             

              
 

                          
1 1

t t

u v u v u w u w

y y x y x z z x z x
   

 

                   
                 

                      
 

   2 2 21 1

2 2
k u u v v w w u v w               (2.50) 
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                   
1 1 1 1

t t t t

u u v w

y y z z x y x z
       

   

              
              

              

 

                   t t t t

u u v w

y y z z x y x z
       

              
              
              

     (2.53) 

After rearranging the momentum equation of x-component becomes 

u uu uv uw

t x y x

   
  

   
     

1
t t t

p u u u

x x x y y z z
     



           
            

           

 

                                            
1 2

3
t

u v w
k

x x x y z
  



    
    
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  
  

  
 

                                              

     
1 1 2

3
t t t

p u u u
k

x x x y y z z x
      

 

              
               

              
 

     
1 2

3
t t t

u u u
p k

x x x y y z z
      



            
              

             
                  (2.54) 

     
1

t t t

u uu uv uw P u u u

t x y z x x x y y z z
     



               
               

               

 (2.55) 

y-component 

     
1

t t t

v vu vv vw P v v v

t x y z y x x y y z z
     



               
               

               

 (2.56) 

z-component 

     
1

t t t

w wu wv ww P w w w

t x y z z x x y y z z
     



               
               

               

 (2.57) 

Where, 

P = Modified pressure 
2

3
p k   

 = Molecular kinematic viscosity 



  
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t = Turbulent kinematic viscosity t


  

In these equations, the viscosity is replaced by the sum of molecular viscosity and turbulent 

viscosity. Now the main task of the closure form is to find the distribution of turbulent viscosity 

or turbulent kinematic viscosity in the solution domain. And this can be done by solving two 

differential or transport equation referred as two-equation models. One represent the generation 

and transport of turbulence and other represent the transport of dissipation of turbulence [26]. 

2.2.1 k   Turbulence Model 

k  Turbulence model is widely used for turbulent flow condition to simulate the mean flow 

characteristics. Jones and Launder [3] were the first to derive the equations that constitute the 

model. Further analyses leading to modifications of the constants were carried out by Launder 

and Sharma [4]. The k  model focuses on the mechanisms that affect the turbulent kinetic 

energy (per unit mass) k . The complete derivation for turbulent kinetic energy is given in 

Appendix A. The other parameter  is the dissipation rate of k . If k and are known we can 

model the turbulent viscosity as: 

2

t

k
C 


     or  

2

t

k
C


                                                                                             (2.58) 

The differential transport equations required for the standard k   model, for the case of 

constant fluid property can be are 

k k k k k k kt t tu v w Q
t x y z x y zx y zk k k

  
   

  

          
                              

        
          

        
 (2.59) 

2

1 2
t t tu v w C Q C

t x y z x y z k kx y z
           

     

          
          
          
          

        
          

        
 

(2.60) 

Where, k  (turbulent Prandtl number) is a closure coefficient and Q is the rate of production 

of k due to Reynolds stress and mean flow, 

2 2 2 2 2 2

2
u v w u v v w w u

Q t t
x y z y x z y x z

 

   
                                         
                      
   

                                             (2.61) 

Standard value of model constants of the k   turbulence model used in the model equations 

are: 
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          0.09C           1.441C          1.922C                1.0k                1.3                       (2.62) 

 

2.3 Near Wall modeling and wall function 

Due to the presence of solid boundary or walls, increasing importance of viscous effects are 

caused to change the structure of turbulent flow. Near wall region have larger gradients in the 

solution variables, and momentum and other scalar transports occur more vigorously, Salim 

[29]. Based on corresponding wall y
 value, it can be seen that the viscosity affected region is 

constitute of three zones which is well explained from Fig. 2.1.  

 Viscous sublayer 

 Buffer layer or blending region  

 Fully turbulent or log-law region 

 

 

 

 

 

 

 

 

 

 

 

 

 

At the solid wall the fluid is stationary and the behavior of the fluid closest to the wall is 

dominated by the viscous effects. This viscous sub-layer is in practice extremely thin  5y 

Fig. 2.1: Boundary layer velocity profile [29] 
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and we assume the shear stress is approximately constant and equal to the wall shear stress w  

throughout the layer. So, 

w

u

y
 





                                                                                                                          (2.63)       

wu y     or wu y C                                                                                             (2.64) 

If 0y   then 0u   get 0C    it comes   w y
u




  

Introducing two important non dimensional parameters u and y
defined by 

*

u
u

u

  and *u y
y



                                                                                                          (2.65) 

Where *u   Friction velocity in the near wall region
*

wu



   

After using this two non-dimensional parameter in the equation we get, 

*

*

w w wy y
u u u u y

u

    

  

 
         (2.66) 

Because of this linear relationship between velocity and wall distance of the fluid layer adjacent 

is also known as the laminar sub-layer. 

Outside the viscous sub-layer  30 500y   a region exist where viscous and turbulent 

effects are both important. The shear stress vary slowly with distance from the wall, and within 

thus inner region it is assumed to be constant and equal to the wall shear stress.  

Considering Prandtl’s mixing length hypothesis 

2

m

u
u v l

y

  
     

   

 (2.67) 

Where the mixing length is given by 

ml y  where  is called Von-Karman constant.  

And 
2

*u v u    

After putting this into Equation (2.67) get 
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2

2 2 2

*

u
y u

y


 
 

 
                                                                                                               (2.68)       

*

u
y u

y


 
 

 

                                                                                                                    (2.69) 

1u

y y




 





                                                                                                                       (2.70) 

Integrating this equation between 0  to y
 get  

1
lnu y B



    (2.71) 

Numerical values for the constants are found from measurements: Von-Karman constant 

0.4  and the additive constant 5.5B  for smooth wall, wall roughness causes a decrease in 

the value of B. The above Equation (2.71) is called the log-law. 

 

2.4 Free-Surface Flows 

A ship hull moving in the water must incorporate both water, air, and the boundary between 

them. The position of the boundary is known only at the initial time; its location at later times 

has to be determined as part of the solution. The most frequently used method to capture the 

free surface in ship hydrodynamics is the Volume of Fluid (VOF) technique. 

The VOF model [30] description assumes that all immiscible fluid phases present in a control 

volume share velocity, pressure and temperature fields. Therefore, the same set of basic 

governing equations describing mass, momentum, and energy transport in a single-phase flow 

is solved.  In this volume of fluid (VOF) method, in addition to the conservation equations for 

mass and momentum, it is required to solve an equation for the filled fraction of each control 

volume, α so that α=1 in filled control volumes (CVs) and α=0 in empty CVs. From the 

continuity equation, the evolution of α is governed by the transport equation: 

 ( ) 0div
t





 


v  (2.72) 

 

Both fluids act as a single fluid whose properties vary in space according to the volume fraction 

of each phase [31], i.e.: 
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 

 

1 2

1 2

1

1

   

   

  

  
                                                                                                            (2.73) 

The interface is simply the location where the fluid properties change abruptly. Then, a 

modified set of the Navier-Stokes equations can be used for the averaged fluid properties, 

21i i i
j i

j i j j

u u p u
u S

t x x x x




   
    

    
                                                                                (2.74) 

This formulation of the Navier-Stokes equations contains an additional source term, iS , 

accounting for the momentum exchange across the interface due to surface tension forces. This 

surface tension force has to be modelled correctly which can be a problem and expressed by 

   dfsF grad c


                                                                                                           (2.75) 

where, surface curvature,  
 c

 c

grad
div

grad


 
    

 
 

2.5 Hull Resistance 

The ship hull experience the force of combination of both air and water against its movement 

called the total hull resistance. The total resistance has its two major components. The frictional 

resistance comes from the frictional or shear forces generated by the water flow and acts on the 

hull surface. The pressure developed normal to the surface is responsible to push the water 

from the hull surface and this developed pressure is the source of other component: residuary 

resistance. The traditional RANSE solver software divides the total resistance into a Reynolds 

number (𝑅𝑛) dependent component, Frictional coefficient (𝐶𝐹) and Froude number (𝐹𝑛) 

dependent component, residuary resistance coefficient (𝐶𝑅) 

𝐶𝑇 = 𝐶𝐹(𝑅𝑛) + 𝐶𝑅(𝐹𝑛)                                                                                                           (2.76) 
 

where CT denotes total resistance coefficient while CR is the residual resistance coefficient and 

CF is frictional resistance coefficient. And, 

𝑅𝑛 =
𝜌𝑈𝐿

𝜇
 𝑎𝑛𝑑 𝐹𝑛 =

𝑈

√𝑔𝐿
                                                                                                                          (2.77) 

The coefficients are non-dimensionalized by 
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21/2

Px

V
C

x 
  (2.78) 

where x in the subscript of Cx may refer to any resistance component. Total Resistance 

coefficient 𝐶𝑇 is defined by, 

𝐶𝑇 =
𝑅𝑇

1
2

𝜌𝑆𝑈2
                                                                                                                                                 (2.79) 

The pressure/residuary resistance coefficient can be split into  

C C C
R W VP

 (2.80) 

where CW is the wave resistance coefficient and CVP is the viscous pressure resistance 

coefficient. Note that a fully submerged body inside a fluid of infinite depth has zero wave 

resistance (no free-surface effect) and the pressure resistance coefficient in this case becomes 

equal to the viscous pressure resistance coefficient. 

2.6 Hull Induced Waves 

The ship hull moves on the undistributed water surface crates the varying pressure field is 

caused for the wave generation. The water creates both diverging waves spread outward from 

the hull and transverse wave following behind the stern of the ship hull known as the Kelvin 

wave pattern. The pattern of wave change as the speed changes and consequently the wave 

length, the relative location of crest and trough of bow and stern waves are also changed. The 

bow wave system starts with a crest aft of the bow and stern wave system starts with a trough 

forward of the stern as shown in Fig. 2.2.  

 

Fig. 2.2: The bow and stern wave systems [32] 
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A higher wave height generates when crest of the bow and stern wave coincide and therefore 

wave resistance will be higher. The opposite i.e. a lower wave height generates when crest of 

bow wave coincides with the trough of stern wave (vice versa) and wave resistance will be 

lower. These interference effect between the wave systems is reason for the hump and hollow 

condition in the resistance curve [33-34]. 

2.7 Rigid Body Dynamics 

In modeling ship dynamics, the ship hull is assumed as rigid body with zero speed and has 6 

degrees of freedoms (DOF) with three translational and three rotational motions as shown in 

Fig. 2.3.  

 

 

Xing-Kaeding, Y. [35] described that the equations of the rigid body motion are coupled with 

the flow solver for computing the interaction between fluid flow and rigid body motion. The 

motion of the rigid body is strongly influenced by the forces acting on the body surface from 

the fluid flow around the body. The forces acting on the body consist of field forces and surface 

forces. The surface forces can be integrated from the pressure and shear forces acting on the 

body surface and the field forces are usually regarded as gravity force. The resultant force F  

can be computed by the following expression: 

Fig. 2.3: Representation of Ship motion with 6 DOF [30] 
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 .  
S

p dS mg  F T l n  (2.81) 

Here, F  is the total fluid force determined by integrating the pressure field and viscous stresses, 

obtained from the RANS equations. T stands for the viscous stress tensor whose components 

are ij (acts on each CV face) introduced in section 2.1, p is the pressure, n the normal vector 

to each control volume (CV) face, and S the CV face area. 

Field forces do not contribute to the moment around the center of mass, but the moments 

due to surface forces (pressure and shear forces) need to be integrated: 

   .  
S

p dS    GM r r T l n  (2.82) 

Here the vector r  represents the position of a certain point on the body surface and Gr  the 

position of the mass center of the body. 

2.7.1 Sinkage and Trim 

In response to the resultant force and moment, STAR-CCM+ simulate the motion of the rigid 

body by solving the governing equation and also find the new position of the body. DFBI 

module allows to calculate the free motion in which selected motions are taken as active to be 

calculated and other motions are remain as frozen/constrained. The motion solver calculates 

the motion and the vertices of the grids are moved simultaneously (STAR-CCM+ user guide 

2011 [30]).  

The equation for the translation of the center of mass: 

d
m

dt


v
f

 
(2.83) 

Where m represents the mass of the body, f is the resultant force acting on the body and v  is 

the velocity of the center of mass.  

The equation of rotation of the body: 

d

dt


   M M n

 
(2.84) 

where M  is the tensor of the moments of inertia,   is the angular velocity of the rigid body 

and n is the resultant moment acting on the body. The tensor of the moments of inertia is 

expanded as: 
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M M Mxx xy xz

M M Mxy yy yz

M M Mxz yz zz

 
 
 
 
 
 

M

 

(2.85) 

Only principal diagonal components  , ,M M Mxx yy zz  are used for the simulation. The governing 

equations for one-DOF rotating and translating body are given, which are solved by DFBI 

translation and motion solver to calculate the sinkage and trim of the hull. When the forces and 

moments are acquired by Equations (2.81) and (2.82), the motions of ship can be calculated by 

Equations (2.83) and (2.84). The numerical scheme of the body motions (Translational and 

Rotational) are derived in the Appendix B. 
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3 Chapter 3 

Numerical Methods 

The complex fluid flows and related phenomenon have already been developed by partial 

differential equation in Chapter 2. These complex equations cannot be solved analytically 

except in special case. Therefore numerical techniques are needed to solve these problem on 

the computer and so arise the discretization method: a method of approximating the differential 

equations by a system of algebraic equations for the variables at some set of discrete locations 

in space and time. This chapter will present discretization approaches, CFD technique, source 

of error and uncertainty which are based on Tu et al. [25] and Moukalled et al. [36]. 

3.1 Discretization Process 

The numerical solution of a partial differential equation consists of finding the values of 

dependent variable  at specified points from which its distribution over the domain of interest 

can be constructed. These points are called grid element. The resulting nodes or variable are 

generally positioned at cell centroids. The distribution of  is hence discretized and converting 

the governing equation into a set of algebraic equations for the discrete values of  as the 

discretization process and the specific methods employed to bring about this conversion as the 

discretization methods [36]. 

3.1.1 Geometric and Physical Modeling 

A physical phenomenon cannot generally be considered as understood unless it can be 

mathematically formulated and this formulation tested and validated. A three dimensional 

domain could be turned into a two dimensional depiction, or symmetry can be taken into 

account to decrease the size of the study domain. In some cases, physical components may be 

removed and replaced with appropriate mathematical representation [36].  

3.1.2 Domain Discretization 

The geometric discretization of the physical domain results in a mesh on which the 

conservation equations are eventually solved. This requires the subdivision of the domain into 

discrete cells or elements that completely fill the computational domain to yield a grid or mesh 

system. The mesh system is composed of discrete elements defined by a set of vertices and 

boundary by faces. The mesh can be described from different perspectives.
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At the most elementary level it is a list of vertices or points representing locations in one 

dimensional, two dimensional, or three dimensional. Elements are completely bounded by 

faces that are generally shared by neighboring element, except at the boundaries. The mesh 

faces, which are stored in a list, are of two types: (i) interior faces that are shared by (or connect) 

two elements, and (ii) boundary faces that coincide with the domain boundary; these boundary 

faces have only one contiguous element. While interior faces are derived from information 

related to the element topology, it is essential to provide boundary faces as they define the 

domain physical boundary. In two dimensions faces are described in terms of their defining 

points. In three dimensions the defining points describe edges that bound the face. The direction 

of the normal to an interior face is usually defined based on the topology of the neighboring 

elements. On the other hand, the direction of the normal to a boundary face always points 

outward of the domain [36]. 

3.2 Discretization of Governing Equations by FVM 

The finite volume method (FVM) discretizes the integral form of the conservation equations 

directly in the physical space. It was initially introduced by the researchers such as McDonald 

[37] and MacCormack and Pauullay [38] for the solution of two-dimensional time-dependent 

Euler equations, and later extended to three-dimensional flows by Rizzi and Inouye [39]. The 

computational domain is subdivided into a finite number of contiguous control volumes, where 

the resulting statements express the exact conservation of relevant properties for each of the 

control volumes. At the centroid of each of the control volumes, the variable values are 

calculated. Interpolation is used to express variable values at the control volume surface in 

terms of the center values and suitable quadrature formulae are applied to approximate the 

surface and volume integrals [38]. An algebraic equation for each of the control volumes can 

be obtained, in which a number of the neighboring nodal values appeared.  

 

 

  

Fig. 3.1: A three dimensional control volume with CVs face [40] 
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The governing equations of fluid flow can be generalized by introducing a generic transport 

variable   as there are significant commonalties between the fluid flow equations and written 

in the following form [25]: 

     u v w
S

t x y z x x y y z z


                  
                          

 (3.1) 

  

Continuity  

1;  0;  0S                                                                                                                  (3.2)  

Momentum 

1 1 1
, , ;  ;  ,  ,  t

p p p
u v w S

x y z
  

  

  
       

  
                                                       (3.3) 

Turbulent quantity 

2

1 2, ;  ,  ;  ,  t t

k

k S Q C Q C
k k

  



   
    

 
                                                       (3.4) 

Here  is the diffusion coefficient and S is the source term. 

Eqn. (3.1) contains an unsteady term 
t




which can be approximated by applying the first-

order forward-difference [40] scheme. 

1n n

P P

t t

   


 
 (3.5) 

Where t is the incremental time step and the superscripts n and 1n denote the previous and 

current time levels respectively.  

By applying the finite volume-method based on the elemental volume (Fig. 3.1) the remaining 

term in Equation (3.1) become, 

   
   

6

1

1 1 1x x

i

i iV A

u u
dV u dA u A

x V x V V

 
 



 
  

    
   

 

              
1 x x

e we w
u A u A

V
    

  [The projection area in the y and z direction are zero]    
 



Chapter 3: Numerical Methods 

 

27 

 

            
1

e e E w w Wu A u A
V

    
 (3.6) 

Using the Taylor series expansion, the interface values e and w at the respective cell face e

and w can be obtained via linear interpolation between the neighboring points as 

2

P E
e

 





2

P W
w

 



                                                                                                     (3.7) 

Using these relationship, Equation (3.6) becomes, 

  1

2 2

P WP E
e E w W

u
u A u A

x V

     
  

   
 (3.8) 

Similarly, 

  1

2 2

P N P S
n N s S

v
v A v A

y V

       
  

   
  (3.9) 

  1

2 2

P T P B
t T b B

w
w A w A

z V

       
  

   
 (3.10) 

 

For the right hand side of Equation (3.1) 
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1

E W

e w

A A
V x x

      
       
      

 (3.11) 

Assuming the linear gradient profile spanning the nodal points between P  and E  and between 

P  and W to sufficiently approximate the first-order derivatives at e and w , the diffusive fluxes 

are evaluated as 

E p

E e E

e PE

A A
x x

 



  
     
   

 (3.12) 

P W
W w W

w PW

A A
x x

 



  
     
   

 (3.13) 

Substituting these values into Equation (3.11) 
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1 E p P WA Ae E w W
x x V x xPE PW

   

 

       
                  

 (3.14) 

Similarly, 

1 N p P SA An N s S
y y V x xNE SW

   

 

       
                  

 (3.15) 

1 T p P BA At T b B
z z V x xTE BW

   

 

       
                  

 (3.16) 

And finally the remaining part, 

1
S dV S

V
V

 


 (3.17) 

Where S is assumed to be constant within the finite-control volume V . Now it should be 

noted that a suitable time-marching procedure needs to appropriately update the property   at 

the central point P and the neighboring points through time. Considering a time-marching 

procedure that requires the solution for all the variable at the time level 1n  and the Eqn. (3.1) 

can be written as, 

1 11 1 1 11 1 1
1 1 1

2 2 2 2

n nn n n nn n n n
n n n n PP W P N SP P P Eu A u A v A v Ae E w W n N s S

t

                      


 
 

1 1 1 1
1 1

2 2

n n n n
n nP T P Bw A w At T Bb

         

1 11 1
1 1

n nn n
n n P WE PA Ae E w W

x xPE PW

  

 

           
  

   

 (3.18) 

1 11 1 1 1 1 1
1 1 1 1 1

n nn n n n n n
n n n n nPN P S T P P BA A A A S Vn N s S t T Bbx x x xNE SW TE BW

      

   

                             
       

      

  

The property  at the central point P  as well as the properties at the neighboring points are 

required to be solved simultaneously and possibly coupling with other flow variables such as 

pressure and temperature appearing in the source term S at the current time level within the 

same difference equation illustrated in the Fig. 3.2. In this implicit approach, the unknowns 

must be obtained by means of a simultaneous solution of the difference equations applied at all 

grid nodal points at a time level [25].  

 

Fig. 3.2: Illustration of an implicit method [25] 
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3.3 Solution of Discretized Equations 

The incompressible form of the conservation equations of governing the fluid flow are already 

derived. Solution to the governing equations is complicated by the lack of an independent 

equation for pressure. In each of the momentum equations, the fluid flow is driven by the 

contribution of the pressure gradients. With the additional equation provided by the continuity 

equation, the system of equations is self-contained; there are four equations for four dependents 

, , ,u v w and p  but no independent transport equation for pressure. The implication here is that 

the continuity and momentum equations are all required to solve for the velocity and pressure 

fields in an incompressible flow. In order to link the pressure with the velocity for an 

incompressible flow, one possible way is to construct the pressure field so as to guarantee 

conservation of the continuity equation [25]. The most popular schemes for pressure-velocity 

coupling for an incompressible flow belongs to the class of iterative methods, which is in a 

scheme called SIMPLE (Semi-Implicit Method for Pressure-Linkage Equations). This scheme 

was developed for practical engineering solutions by Patankar and Spalding [41]. However, 

this scheme must be extended to transient calculation due the problem contains unsteady term. 

In this scheme, a guessed pressure field is used to solve the momentum equation. A pressure 

correction equation deduced from the continuity equation, is then solved to obtain a pressure 

correction field, which in turns is used to update the velocity and pressure fields. These guessed 

fields are progressively improved through the iteration process until convergence is achieved 

for the velocity and pressure fields.  

 

3.4 Collocated Grid Arrangement 

In the collocated grid arrangement (Fig. 3.3), all the flow-field variables including the 

velocities are stored at the same set of nodal points. Since many of the terms in each of the 

equations are essentially identical, the number of coefficients that must be computed and stored 

is minimized and the programming is simplified by this arrangement choice.  A set of control 

volumes can be designed to fit the boundary including the discontinuity. Other arrangements 

of the variables lead to some of the variables being located at singularities of 

the grid, which may lead to singularities in the discretized equations. In a collocated grid, the 

coefficients of this equation cannot be directly computed, they are approximated by 

interpolation from the coefficients of the neighboring nodes. 
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3.5 Semi Implicit Method for Pressure –Linked Equation (SIMPLE) 

The problems associated with the non-linearities in the equation set and the pressure–velocity 

linkage can be resolved by adopting an iterative solution strategy such as the SIMPLE 

algorithm. 

For the control volume shown in Fig. 3.4, the application of the finite-volume method to the 

continuity equation produces the following discretized form [42] of the equation 

     , , 1, , , , , 1, , , , , 1 0i j k i j k i j k i j k i j k i j ku u y z v v x z w w x y               (3.19) 

 

x -momentum equation 

      2 2 2

2 2 2

1uu uv uwu p u u u

t x y z x x y z




        
       

        
 (3.20) 

Integrating over the u -control volume, we can write, 

  2

, , 1, ,

1
0n

i j k j k

x y z u u u p
u u u uv uw dxdydz dxdydz

t x x y y z z x
  



              
             

            
   (3.21) 

Applying the Green’s theorem to the above expression 

 

 

Fig. 3.3: Collocated grid arrangement of velocity componenets [25] 

Fig. 3.4: Nodal indexing of elemental cell in three dimensions [25] 
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 , , 1, , 1 1 1 1 1 1
, , , , , , , , , , , ,

2 2 2 2 2 2

n

i j k j k
i j k i j k i j k i j k i j k i j k

x y z
u u L L y z M M x z N N x y

t      

       
                 

      

1
0

p
V

x


  



 
(3.22) 

Where, 

2 u
L u

x

u
M uv

y

u
N uw

z








 




 




 



                                                                                                       (3.23) 

are the axial, transverse and vertical fluxes of x-momentum. 

 
 2 1, , , ,

1 1, , , ,
, ,

2

1

4

i j k i j k

i j k i j k
i j k

u u
L u u

x








  


 (3.24) 

 
 2 , , 1, ,

1 , , 1, ,
, ,

2

1

4

i j k i j k

i j k i j k
i j k

u u
L u u

x








  


 (3.25) 

  
 , 1, , ,

1 , 1, , , 1, , , ,
, ,

2

1

4

i j k i j k

i j k i j k i j k i j k
i j k

u u
M u u v v

y




 



   


 (3.26) 

  
 , , , 1,

1 , , , 1, 1, 1, , 1,
, ,

2

1

4

i j k i j k

i j k i j k i j k i j k
i j k

u u
M u u v v

y




   



   


 (3.27) 

  
 , , 1 , ,

1 , , 1 , , 1, , , ,
, ,

2

1

4

i j k i j k

i j k i j k i j k i j k
i j k

u u
N u u w w

z




 



   


 (3.28) 

  
 , , , , 1

1 , , , , 1 1, , 1 , , 1
, ,

2

1

4

i j k i j k

i j k i j k i j k i j k
i j k

u u
N u u w w

z




   



   


 (3.29) 

Substituting above terms in Equation (3.22) get 

 , , , ,

n

i j k i j k

x y z
u u

t

  




   , , 1, , , , 1, , 1, , , ,

1 1

4 4
i j k i j k i j k i j k i j k i j k

y z y z
u u u y z u u u y z

x x

 
  

      
            

    

   , , , , 1, , 1, , , , 1, ,

1 1

4 4
i j k i j k i j k i j k i j k i j k

y z y z
u u u y z u u u y z

x x

 
  

      
            

    
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   , , 1, , , , , 1, 1, , , ,

1 1

4 4
i j k i j k i j k i j k i j k i j k

x z x z
u v v x z u v v x z

y y

 
  

      
            

    

   , , 1, 1, , 1, , 1, 1, 1, , 1,

1 1

4 4
i j k i j k i j k i j k i j k i j k

x z x z
u v v x z u v v x z

y y

 
      

      
            

    

   , , 1, , , , , , 1 1, , , ,

1 1

4 4
i j k i j k i j k i j k i j k i j k

x y x y
u w w x y u w w x y

z z

 
  

      
            

    

   , , 1, , 1 , , 1 , , 1 1, , 1 , , 1

1 1 1
0

4 4
i j k i j k i j k i j k i j k i j k

x y x y p
u w w x y u w w x y V

z z x

 


      

       
               

     

  (3.30) 

or, 

     1, , , , , , 1, , 1, , , ,

1 1 1

4 4 4
i j k i j k i j k i j k i j k i j k

x y z
u u y z u u y z v v x z

t
  

  
            

     1, 1, , 1, 1, , , , 1, , 1 , , 1

1 1 1

4 4 4
i j k i j k i j k i j k i j k i j kv v x z w w x y w w x y                 

, ,i j k

y z y z x z x z x y x y
u

x x y y z z

                 
      

      

   1, , 1, , , , 1, , , , 1, ,

1 1

4 4
i j k i j k i j k i j k i j k i j k

y z y z
u u u y z u u u y z

x x

 
   

       
                 

   , 1, 1, , , , , 1, 1, 1, , 1,

1 1

4 4
i j k i j k i j k i j k i j k i j k

x z x z
u v v x z u v v x z

y y

 
     

      
            

    

   , , 1 1, , , , , , 1 1, , 1 , , 1

1 1

4 4
i j k i j k i j k i j k i j k i j k

x y x y
u w w x y u w w x y

z z

 
     

       
                

, ,

1
0n

i j k

x y z p
u V

t x

   
   

 
                                                                                                  (3.31) 

The above equation can be written as, 

, , , ,

1u u u

i j k i j k nb nb

x y z p
a u a u b V

t x

    
     

  
  

(3.32) 

In this equation 
u

nb nba u signifies all the convective and diffusive contribution from the 

neighboring nodes. The coefficients , ,

u

i j ka and 
u

nba contain grid size. , ,

u n

i j k

x y z
b u

t

  



.  

Similarly for y and z momentum equation can be written as 
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, , , ,

1v v v

i j k i j k nb nb

x y z p
a v a u b V

t y

    
     

  
  

(3.33) 

, , , ,

1w w w

i j k i j k nb nb

x y z p
a w a u b V

t y

    
     

  
  

(3.34) 

 

3.5.1 Solution Algorithm 

When solving an unsteady problem, the time step is chosen so that an accurate history is 

obtained. Due to the non-linearity and coupling of the underlying differential equations 

iterative solution is the only choice. For an unsteady flow and time accuracy is required, 

iteration must be continued within each time step until the entire system of non-linear equations 

is satisfied to within a narrow tolerance. The iterative SIMPLE calculation process begins by 

guessing the pressure field,
*p . During the iterative process, the discretized momentum 

equations are solved using the guessed pressure field [25]. Applying the finite-volume method, 

the equations for the x, y, and z momentum that yield the velocity components 
* *, ,u v and *w , 

can be expressed in the same algebraic equations same as Equations (3.32), (3.33), and (3.34) 

, ,

*
* *

, ,

1
i j k

u u u

i j k nb nb

x y z p
a u a u b V

t x

          
  

  (3.35) 

, ,

*
* *

, ,

1
i j k

v v v

i j k nb nb

x y z p
a v a v b V

t y

          
  

  (3.36) 

, ,

*
* *

, ,

1
i j k

w w w

i j k nb nb

x y z p
a w a w b V

t z

          
  

  (3.37) 

Here, we simplify the above expressions by introducing nba to represent the presence of 

neighboring coefficients, and 
* *, ,nb nbu v and

*

nbw to denote the neighboring nodal velocity 

components. If we define the correction p as the difference between the correct pressure field 

and the guessed pressure field, we obtain 

*p p p   (3.38) 

Similarly, we can also define for the velocity components 

*

*

*

u u u

v v v

w w w

 

 

 

                                                                                                                        (3.39) 
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The algebraic form of the correct velocities can also be similarly expressed as in Equations 

(3.35), (3.36), and (3.37) 

, , , ,

1u u u

i j k i j k nb nb

x y z p
a u a u b V

t x

          
  

  (3.40) 

, , , ,

1v v v

i j k i j k nb nb

x y z p
a v a v b V

t y

          
  

  (3.41) 

, , , ,

1w w w

i j k i j k nb nb

x y z p
a w a w b V

t z

          
  

  (3.42) 

Subtracting Equations (3.40) and (3.35), (3.41) and (3.36), and (3.42) and (3.37) 

   
 

, ,

*

* *

, , , ,

1
i j k

u u

i j k i j k nb nb nb

p px y z
a u u a u u V

t x

    
      

  
  (3.43) 

   
 

, ,

*

* *

, , , ,

1
i j k

v v

i j k i j k nb nb nb

p px y z
a v v a v v V

t y

    
      

  
  (3.44) 

   
 

, ,

*

* *

, , , ,

1
i j k

w w

i j k i j k nb nb nb

p px y z
a w w a w w V

t z

    
      

  
  (3.45) 

 

Using the correction formula Equations (3.43), (3.44), and (3.45) can be rewritten as 

, , , ,

1u u

i j k i j k nb nb

x y z p
a u a u V

t x

    
     

  
  (3.46) 

, , , ,

1v v

i j k i j k nb nb

x y z p
a v a v V

t y

    
     

  
  (3.47) 

, , , ,

1w w

i j k i j k nb nb

x y z p
a w a w V

t z

    
     

  
  (3.48) 

The SIMPLE scheme approximate the above three equations by omissions of terms 

,u v

nb nb nb nba u a v   and
w

nb nba w . This scheme is an iterative approach and we are allowed to 

construct a formula for p that is simply a numerical artifice with the aim to expedite the 

convergence of the velocity field to a solution that satisfies the continuity equation. Once the 

pressure correction field is known, the correct velocities , ,u v and w can be obtained through the 

guessed velocities 
* *, ,u v and *w from the simplified equations (3.46), (3.47), and (3.48) 
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, ,

*

, , i j k

u

i j k

p
u u F

x


 


 (3.49) 

, ,

*

, , i j k

v

i j k

p
v v F

y


 


 (3.50) 

, ,

*

, , i j k

w

i j k

p
w w F

z


 


 (3.51) 

Where, 

      

, ,

u

u

i j k

V
F

x y z
a

t





   
 

 
, ,

v

v

i j k

V
F

x y z
a

t





   
 

 
, ,

w

w

i j k

V
F

x y z
a

t





   
 

 

 

  

These correction formulae can be applied to any location, where the velocity components reside 

within the computational grid. The general form of the velocity correction formulae, by 

removing the subscript , ,i j k can be written as 

* u p
u u F

x


 


 (3.52) 

* v p
v v F

y


 


 (3.53) 

* w p
w w F

z


 


 (3.54) 

By differentiating Equations (3.52), (3.53), and (3.54) by the Cartesian direction x, y, and z 

respectively and summing them together [25] 

* * *
u v wu v w u v w p p p

F F F
x y z x y z x x y y z z

                 
           

               
                 (3.55) 

But, 

0
u v w

x y z

  
  

  
                                                                                                              (3.56) 

* * *
u v wp p p u v w

F F F
x x y y z z x y z

              
        

            
 (3.57) 

Once the pressure correction is obtained from Equation (3.57), the pressure and velocity 

components are subsequently updated through the correction formulae of Equations (3.52), 

(3.53), and (3.54). The right hand side of Equation (3.57) commonly known as the mass 

residual. The sequence of operations in CFD process that embodies the transient SIMPLE 

scheme is given in Fig. 3.5. 
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Fig. 3.5: Solution algorithm of Transient SIMPLE Scheme [25, 36] 
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3.6 Convergence 

Convergence of a numerical process can be stated as the solution of the system of algebraic 

equations approaching the true solution of the partial differential equations having the same 

initial and boundary conditions as the refined grid system. In the majority of commercial CFD 

code, the system of algebraic equations is usually solved iteratively. When dealing with these 

codes, there are three important aspects to abide by for the iterative convergence. First, all the 

discretized equations are needed to be converged when they reach a specified tolerance at every 

nodal section. Second, the numerical solution no longer changes with additional iterations. 

Third, overall mass, momentum and scalar balances are obtained. During the numerical 

procedure, the imbalances of the discretized equations are monitored and these defects are 

commonly referred to as the residuals of the system of algebraic equations that is they measure 

the extent of imbalances arising from these equations and terminate the numerical process when 

a specified tolerance is reached. For satisfactory convergence, the residuals should diminish as 

the numerical process progresses [25]. 

For any transport variable , the discretized form of the partial differential equation can be 

specially written as: 

, , , , , ,i j k i j k nb nb i j ka a b    (3.58) 

In the equation (3.58) the central coefficient , ,i j ka and neighboring coefficients nba normally 

depend on the solution of other flow-field variables including the time and spatial varying fluid-

flow properties. These coefficients are updated consecutively during the iterative procedure. 

At the start of each iteration step, the equality in equation (3.58) will not hold. Therefore, 

rewrite the above equation by introducing an imbalance variable called residual , ,i j kR  and the 

above is re-expressed as 

, , , , , , , ,i j k nb nb i j k i j k i j kR a b a     (3.59) 

For a well-posed formulation, the residuals become negligible with increasing iterations. In 

CFD, residuals are employed to monitor the behavior of the numerical process. Importantly, 

they implicate whether the solution shows a trend of convergence or divergence.  
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The residual actually depicts the imbalance at the nodal point for one cell volume. For practical 

purposes, a global residual R , taken as the sum of the each local residual , ,i j kR over all the grid 

nodal points, is monitored:  

, ,

nt

i j k

grid poi s

R R   (3.60) 

Convergence is deemed to be achieved for the discretized equation so long as the global 

residual R satisfies a specified tolerance, that is 

R  or , ,

nt

i j k

grid poi s

R                                                                                                   (3.61) 

The variable  is usually referred to as the convergence tolerance for the system of algebraic 

equations. Specifying appreciably small tolerance values will incur a large number of iteration 

steps in reaching convergence. On the other hand, large tolerance values constitute an early 

termination of the iteration process for which the numerical solution of the algebraic equations 

is considered to be rather coarse or not sufficiently converged. The residual convergence study 

for each hull is drawn from the simulation and given in Appendix C. 

 

3.7 Grid Dependence and Validation 

In CFD problem, uncertainties can arise while performing a numerical simulation. These can 

be due to the improper modeling of physics such as a misunderstanding of the phenomenon 

leading to falsifying assumptions or incorrect computational design such as making wrong 

approximations and simplifications about the parameters that governs the fluid dynamics. 

Therefore, it requires a detailed analysis to be performed to quantify the modeling and 

numerical uncertainties in the simulation. Grid dependence and validation procedures are the 

means by which a CFD solution can be properly assessed through quantitatively estimating the 

inherent errors and uncertainties.  

Grid dependence can be defined as a process for assessing the numerical simulation uncertainty 

and the dependence of the numerical results on the grid refinement.  

Validation can be defined as a process for assessing simulation model uncertainty by using 

benchmark experimental data and when conditions permit, estimating the sign and magnitude 

of the simulation modeling error itself [25]. 



Chapter 3: Numerical Methods 

 

39 

 

The grid dependence and validation methodology are discussed following the published 

literatures by Stern et al. [43] and Wilson et al. [44]. 

3.7.1 Grid Dependence Test 

The test methodology starts with the grid convergence study. For convergence studies ITTC 

[45] recommends a grid refinement ratio 2Gr  , as it provides fairly large parameter 

refinement ratio. Convergence studies require a minimum of m=3 solutions to evaluate 

convergence with respect to input parameter. Changes between medium-fine and coarse-

medium can be written as 

2 121 S S    

3 232 S S    
(3.62) 

1
S ,

2
S , and

3
S are stand for fine, medium and coarse solution. Convergence ratio is defined as 

21 2 1

32 3 2

G

S S
R

S S






 


 (3.63) 

Three convergence conditions are possible: 

i. Monotonic convergence: 0 1GR   

ii. Oscillatory convergence: 0GR   

iii. Divergence: 1GR   

For monotonic convergence, generalized Richardson Extrapolation (RE) [44] is used to 

estimate the grid uncertainty 𝑈𝐺 .  For oscillatory convergence, uncertainties can be estimated, 

but not the signs and magnitudes of the errors. Uncertainties are estimated based on 

determination of the upper  US and lower  LS bounds of the solution oscillation, which 

requires more than three solutions. The estimate of uncertainty is based on half the solution 

range 

 
1

2
G U LU S S   (3.64) 

For divergence, errors and uncertainties cannot be estimated. The preparation and verification 

steps must be reconsidered.  

In case of monotonic convergence, an error 𝛿𝑅𝐸  due to the selection of rth input parameters 

and the order of accuracy can be estimated as, 
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𝛿𝑅𝐸 =
𝜀21

𝑟𝐺
𝑝𝐺 − 1

 
(3.65) 

𝑝𝐺 =
𝑙𝑛(𝜀32 𝜀21⁄ )

𝑙𝑛(𝑟𝐺)
 (3.66) 

 

Correction of Equation (3.65) through a multiplication factor 𝐶𝐺  provides a quantitative metric 

to determine proximity of the solutions to the asymptotic range. Where the correction factor is 

given by, 

𝐶𝐺 =
𝑟𝐺

𝑝𝐺 − 1

𝑟𝐺
𝑝𝐺𝑒𝑎𝑠𝑡 − 1

 (3.67) 

When solutions are beyond the asymptotic range, 𝐶𝐺  is sufficiently less than or greater than 1, 

the magnitude of error is determined through the estimation of grid uncertainty, 𝑈𝐺 given by 

𝑈𝐺 = |𝐶𝐺𝛿𝑅𝐸| + |(1 − 𝐶𝐺)𝛿𝑅𝐸| (3.68) 

 

3.7.2 Validation Procedure 

Validation is targeted through the comparison of simulations with benchmark experimental 

fluid dynamics (EFD) data. The comparison error 𝐸 is defined by, 

𝐸 = 𝑆 − 𝐷 (3.69) 
 

S is the simulation result and D is the experimental data. The validation of the numerical results 

are achieved when the comparison relative error |𝐸|   becomes less than the validation 

uncertainty 𝑈𝑉 level. 

The validation uncertainty |𝑈𝑉| is given by, 

𝑈𝑉 = √𝑈𝑆𝑁
2 + 𝑈𝐷

2 (3.70) 

𝑈𝑆𝑁 is the numerical uncertainty and found by 

𝑈𝑆𝑁 = √𝑈𝐺
2 + 𝑈𝐼

2 (3.71) 

𝑈𝐺  is the grid uncertainty given in the Equation (3.68) and 𝑈𝐼 is the iterative uncertainty.
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4 Chapter 4 

Computational Setup 

The whole simulation is carried out in commercial CFD code STAR-CCM+ version 14.02.010. 

The processes required to run the simulation will be presented and the guidelines for the best 

approaches are selected with the aid of STAR-CCM+ user guide [30]. 

4.1 Co-ordinate System 

A Cartesian coordinate system Oxyz is fixed in the model ship and the origin at the intersection 

of the planes of the mid-ship section and the undisturbed free surface level as shown in Fig. 

4.1. The x direction is positive towards the forward part of the ship, y direction is positive to 

the port side and z direction is positive in the vertically upward direction. The model ship is 

fixed in the position and the free stream velocity, U is parallel to the negative x direction. 

 

 

4.2 Boundary Conditions 

The general view of the computational domain including the ship hull and the notations of its 

boundary conditions is depicted in Fig. 4.2. The computational domain is split into two sub-

domains (air and water) and has an interface between the flow fluids. This entire computational 

domain is bounded by six boundary surfaces such as inlet, outlet, side, symmetry, top and   

bottom.

U 

Fig. 4.1: Coordinate system used in this present study 
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The boundary conditions imposed on each surface are described below (Masuko and Ogiwara 

[46]).  

 

 

(a) Inlet boundary: Similar to inviscid flow problem, the initial velocity components in x, 

y and z direction are selected as,  

     and  0u x u v w    (4.1) 

 

(b) Outlet boundary: The pressure at outlet is assumed to be the hydrostatic on the free 

surface and the shear forces are prescribed zero in order to meet the criteria of stress 

continuity equation. 

0
u v w

n n n

  
  

  
 (4.2) 

 

(c) Side and Symmetry boundary: The axis of symmetry of the computational domain 

and the surface of symmetry (side) plane can be considered as the boundaries. The net 

flow across the symmetry is zero and hence the velocity including the turbulent 

quantities normal to the boundary is set to zero.  

  0,     = = 0
u w k

v
n n n n

   
  

   
 (4.3) 

 

(d) Top and Bottom boundary: The top and bottom boundaries are considered to be the 

wall type and can be written as, 

Fig. 4.2: Computational domain and its boundary conditions 
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0u v w k       (4.4) 

(e) Ship hull: The velocity components (no-slip) and the turbulent quantities on the hull 

are set to zero. 

0u v w k       (4.5) 

 

(f) Wall function: The wall function emulates the behaviour of the flow inside the 

boundary layer. On the first grid point of the body  k and ε become:  

2 3 / 2u k3 / 4k ,
ky

   


 (4.6) 

 

Towards the outer part of the viscous sub layer and the buffer layer, the turbulence is rapidly 

increased by the production of turbulent kinetic energy. With the use of standard k-ε turbulence 

model, additional wall functions are necessary to bridge the solution variables in the viscosity 

affected region. The velocity in the log-law region varies logarithmically with y+ as given by 

Equation (4.7). Although there is a slight variation in the values of universal constants in the 

literature, according to Stanford conventions suggest the von Karman constant κ as 0.41 and 

the equation constant B as 5.0. 

              1
u ln y B

k

    (4.7) 

 

Where u+ is the stream wise velocity non-dimensionalized by the friction velocity uτ, y+ is the 

normalized wall distance such that y yu /  


. At the upstream boundary, the uniform flow 

condition is used. At the downstream boundary, zero derivative condition in x-direction is used 

and the pressure p is taken as hydrostatic. At the symmetry plane boundaries zero derivative 

condition in the normal directions are utilized. 

4.3 Mesh Generation 

The mesh generation constitutes one of the most important steps during pre-process stage after 

the definition of the domain geometry. CFD requires the subdivision of the domain into a 

number of smaller, non-overlapping subdomains in order to solve the flow physics within the 

domain geometry that is created: this yields the generation of mesh of cells. The essential fluid 
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flows that are described in each of these cells are usually solved numerically so that discrete 

values of the flow properties such as the velocity, pressure, and the other transport properties 

of interests are determined. This yields the CFD solution to the flow problem that is being 

solved. The accuracy of a CFD solution is governed by the number of cells in the mesh within 

the computational domain.  

4.3.1 Surface Mesh 

In STAR-CCM+ meshing models are split into two groups: surface mesh models and volume 

mesh models. Meshing strategy begins with the surface meshing modeling and when a high-

quality surface mesh is achieved, go on to the volume meshing models [30]. There are two 

types of surface meshing model: Surface remesher and Surface wrapper. 

To obtain a best surface mesh a global setting with the selection of base size is required in the 

problem simulation. The Base Size is a characteristic dimension of the model that has been set 

before using any relative values. This base size determines the number of cells within the 

domain are generated. It is noted that lower the base size will generate the higher cells and vice 

versa. However, it is recommended that the value of base size should be equal to the 1/40th to 

1/60th of the length of the hull. Base size is the only a global setting which controls the size of 

the whole mesh but it is also allowed to control the surface of the interests based on the base 

size. As the faces of the computational domain are smooth and rectangular in shape, surface 

mesh is generated with an acceptable view as shown in Fig. 4.3.  

 

 

 

 

 

 

 

 

 

 

Fig. 4.3: Surface mesh of the computational domain 
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However, the hull geometry which is a really complex one, surface control is mandatory to 

generate the acceptable surface mesh. And so, beyond the global base size, relative values are 

set as a percentage of the base size at the complex geometry of the hull surface as shown in 

Fig. 4.4. 

 

4.3.2 Volume Mesh 

The volume mesh in a simulation is the mathematical description of the space or geometry of 

the problem being solved. A Trimmed cell mesher and prism layer mesher models are used in 

this mesh generation strategy. Trimmed cell mesher provides a robust and efficient method of 

producing a high-quality grid for both simple and complex geometry problems. The trimmer 

meshing model utilizes a template mesh that is constructed from hexahedral cells from which 

it cuts or trims the core mesh using starting input surface. The template mesh contains 

refinement that is based on the local surface mesh size and local refinement controls. Finite 

volume mesh with hexahedral cell was generated within the whole domain as shown in Fig. 

4.5. 

 

Fig. 4.4: Surface mesh of the KCS hull 
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(a) Computational Domain 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(b) Closed view of hull surface 

Fig. 4.5: Finite volume mesh applied to the domain and hull model 

To capture the free surface efficiently a thin rectangular block is created with high mesh 

resolution at the free surface location which is shown in Fig. 4.6 and at the stern and bow sides 

block small volumetric blocks are created to get better mesh quality as presented in Fig. 4.7. 

Special care is also taken away from the stern of the hull to capture the free surface wave more 

accurately.  



Chapter 4: Computational Setup 

47 

 

 

  

 

 

 

 

 

 

 

(a) Bow region 

 

 

 

 

 

 

 

  

 

(b) Stern region 

Fig. 4.7: Mesh applied at the bow and stern regions 

Fig. 4.6: Refined mesh scene at the free 

surface 



Chapter 4: Computational Setup 

48 

 

A trimmed cell mesher technique is used to produce hexahedral cell and prism layer mesher 

model is applied to resolve accurately the turbulent flow near the solid wall of the hulls. 

Determination of the velocity gradients normal to the wall boundary has a remarkable effect 

on the accurate prediction of the flow features. Hence, prism layer allows to resolve these 

gradients, moreover, prism layer thickness is a region which govern a lot of key characteristics 

to predict the different hydrodynamic behaviors. The first prism layer height normal to the solid 

wall is determined using 60Y  and using the geometric progression relationship which uses a 

stretch factor (constant value, 1.3), the size of the progressive layers are calculated. It is 

recommended that the size of the last layer of the prism should be the closet size to the core 

mesh. 

Table 4.1: Overall thickness of a prism layer for KCS 

 

 

 

 

 

 

 

Layer No. Layer Thickness Overall Thickness 

1 0.00240 0.00240 

2 0.00312 0.00552 

3 0.00405 0.00957 

4 0.00527 0.01484 

5 0.00685 0.02169 

6 0.00891 0.03060 

Solid 

Wall 

Prism 

Layers 

Core 

Mesh 

Fig. 4.8: Generated prism layers with the core mesh 
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4.4 Physics Modeling 

After creating the computational domain and generating the mesh, next step is to set the proper 

physics model and fluid properties. Many industrial CFD flow problems may require solutions 

to very complex physical flow processes. STAR-CCM+ contains a wide range of physics 

models and methods for the simulation of single and multi-phase fluid flow, heat transfer, 

turbulence, solid stress, dynamic fluid body interaction, and related phenomenon.  

Physics models define the primary variables of the simulation (such as pressure, temperature, 

and velocity) and what formulation is used to generate the solution. An appropriate 

combination of models is necessary for the complete definition of a physics continuum.  

4.4.1 Space Modeling 

The primary function of the space model in STAR-CCM+ is to provide methods for computing 

and assessing mesh matrices. The mesh matrices include cell volume and centroid, face area 

and centroid, cell and face indexes, and skewness angle. For space modeling, three-dimensional 

model is selected. The three-dimensional model is designed to work on three-dimensional 

meshes.  

4.4.2 Time Modeling 

Time model in STAR-CCM+ provides solvers that control the iteration and/or unsteady time-

stepping. In RANS equation, there are time varying properties the problem becomes an 

unsteady state. The implicit unsteady is used due to unsteady model available with the 

segregated flow and segregated fluid energy model. In the implicit unsteady approach each 

physical time-step involves some number of inner iterations to converge the solution for that 

given instant of time. These inner iterations may be accomplished using the same implicit 

integration or explicit integration schemes used for steady analysis. 

4.4.3 Materials Modeling 

The material model is responsible for managing the material that is substance or substances, 

being simulated in the continuum. The simulated material is responsible for managing the 

various thermodynamic and transport properties relevant to that material and to the physical 

processes being modeled in the continuum. In the present study, the simulated body is exposed 

to two phases namely air and water. Hence, a multiphase mixture model is selected and this 

model is for simulating two or more immiscible phases, where each phase is composed of pure 
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gas or liquid substance, such as air and water. Materials properties for used two phases (fluid-

fluid) are tabulated below: 

Table 4.2: Material properties for multiphase modeling 

Phase Material Density  3/kg m  Dynamic Viscosity  Pa s  

Liquid Water 1000 31.1375 10  

Gas Air 1.225 51.802 10  

 

4.4.4 Multiphase Flow Modeling 

Multiphase flow is term which refers to the flow and interaction of several phases within the 

same system where distinct interface exist between phases.  Volume of Fluid (VOF) multiphase 

flow model which is provided for systems containing two or more immiscible fluid phases, 

where each phase constitutes a large structure within the system. This approach captures the 

movement of the interface between the fluid phases. In VOF homogenous multiphase model, 

a common velocity and pressure field are assumed for all phases. 

An iso surface is created in this multiphase model which basically represents the free surface 

between the air and water phases. An iso value (volume fraction) 0.5 is selected such that the 

iso surface is created at the z=0 plane (draft line) as shown in Fig. 4.9. 

 

Fig. 4.9: Iso surface generated by multiphase modeling 

z = 0 

Iso Surface 

 0.5  
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Volume fraction is defined by, 

iV

V
                                                                                                                                     (4.8) 

Sum of the volume fraction is unity: 

1
i
                                                                                                                                  (4.9) 

Depend on the value of volume fraction, three conditions are possible: 

1. 0,   The cell is empty of liquid

2. 1,     The cell is completely full of liquid

3. 0 1, The cell contains a free surface











 

        

Fig. 4.10 indicates the initial stage of the simulation, where the value of volume fraction equal 

to 0.5 i.e. the control volume at the free surface contains 50% of water and 50% of air. The 

further away from the free surface, red zone is completely full of liquid  1  and the blue 

zone is empty of liquid  0 . 

 

 

 

 

 

 

 

 

 

4.4.5 VOF Waves 

VOF wave is used to simulate surface gravity waves on a light fluid (air)-heavy fluid (water) 

interface. This is for three-dimensional cases only, and are used with the Volume of Fluid 

(VOF) multiphase model in STAR-CCM+. It is typically used with the 6-DOF Motion model 

for marine applications. When created, VOF Wave provides field functions that can be used to 

Air Region

 0  

Water Region

 1  

Interface            

 0.5  

Fig. 4.10: Free surface at initialization stage of simulation. 
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initialize the VOF calculation and to provide suitable profiles at boundaries. The VOF Wave 

model, when selected, also activates a region condition and a boundary condition to control 

damping of the waves near boundaries in order to reduce wave reflections. 

The simulation is carried out in calm water condition and hence selected Flat wave option 

available in STAR-CCM+. A flat wave represents a calm plane of water, that is, the least 

amount of current. In the flat wave properties, the point on the water level defines the position 

of the water surface that is the load water line. The vertical direction is given normal to the 

water surface. The current and wind velocity for the model is water (heavy fluid) and air (lighter 

fluid) respectively. 

The VOF wave model also includes a VOF wave damping capability. This means that a VOF 

wave can be damped in the vicinity of selected boundaries to reduce wave oscillation near those 

boundaries. The VOF Wave damping option is activated at the outlet boundary of the 

computational domain.  

4.4.6 Turbulence Modeling 

The turbulence models in STAR-CCM+ [28] are responsible for providing closure of the 

governing equations in turbulent Flows. Three basic approaches to modeling turbulence are 

available in STAR-CCM+. 

 Models that provide closure of the Reynolds-Averaged Navier-Stokes (RANS) 

equations. 

 Large eddy simulation (LES). 

 Detached eddy simulation (DES). 

Present problem relies on the first approach. The second two approaches (LES and DES) are 

best used after carefully reviewing the applicable literature to gain confidence that the grid 

resolution requirements can be met and that the computational costs incurred by resolving the 

small time and length scales are indeed justified. 

Eddy viscosity models 

Eddy viscosity models use the concept of a turbulent viscosity t  to model the Reynolds stress 

tensor as a function of mean flow quantities. The most common model is known as the 

Boussinesq [27] approximation: 
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 
2

2
3

t t t k     T S v I                                                                                               (4.10)                                                                                    

Where S is the strain tensor: 

 
1

2

T  S v v                                                                                                                (4.11)                                                                                                        

and k is the turbulent kinetic energy. 

The eddy viscosity models in STAR-CCM+ solve additional transport equations for scalar 

quantities that enable the turbulent viscosity t  to be derived. These include the following 

turbulence models: 

 Spalart-Allmaras models 

 K-Epsilon models 

 K-Omega models 

Among these three models, the K-Epsilon models is selected because this model provides a 

good compromise between robustness, computational cost and accuracy. They are generally 

well suited to industrial-type application that contain complex recirculation, with or without 

heat transfer. 

4.4.7 Wall Treatment Modeling 

A wall treatment in STAR-CCM+ is the set of near-wall modeling assumptions for each 

turbulence modeling. STAR-CCM+ provides three types of wall treatment: 

The high- y
wall treatment assumes that the near-wall cell lies within the logarithmic region 

of the boundary layer and uses a wall function. A wall function is the set of mathematical 

relations that are used to obtain the boundary conditions for the continuum equations. These 

calculations are based on the following assumptions: 

 The turbulence model is valid only outside the viscous-dominated region of the 

boundary layer, and the viscous-affected region of the boundary layer is not resolved; 

and 

 The centroid of the near-wall cell lies within the logarithmic region of the boundary 

layer. 

 Velocity, turbulence, and other scalar quantities are distributed consistently 

The main advantage of using wall functions is the significant savings in terms of near-wall 

mesh resolution. 
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The low- y
 wall treatment is suitable only for low-Reynolds number turbulence models: this 

treatment assumes that the viscous sub-layer is properly resolved. 

Low-Reynolds number turbulence models are valid throughout the boundary layer, including 

the viscous sub-layer. To resolve the viscous sub-layer, these models require a sufficiently fine 

mesh. There is little or no need for modeling to obtain the wall boundary conditions. The 

computational expense that is associated with this approach can be significant, particularly for 

large Reynolds numbers. 

The all- y
wall treatment is a hybrid treatment that attempts to emulate the high- y

wall 

treatment for coarse meshes, and the low- y
wall treatment for fine meshes. It is also 

formulated with the desirable characteristic of producing reasonable answers for meshes of 

intermediate resolution. 

Among the three treatments above, the high- y
wall treatment is applied because this treatment 

can have some computer storage by avoiding the computation of the wall distance when used 

certain high-Reynolds number models. Also this treatment is suitable for use with models that 

do not explicitly damp the turbulence model in the near –wall region.  

Wall treatment formulation for K-Epsilon Model 

To calculate the wall distance and reference velocity, following non-dimensional quantities are 

used: 

*yu
y



                                                                                                                               (4.12) 

*

u
u

u

                                                                                                                                 (4.13)  

y  is the normal distance from the wall to the wall-cell centroid. 

u is the component of wall-cell velocity parallel to the wall. 

*u is a reference velocity. 

For high- y
wall treatment, following terms are calculated as: 

Reference velocity,   
* 1 2u C k                                                                                      (4.14) 

Wall-cell production,  

2

*1
k

u u
G u

u y






 

 
  

 
                                                                  (4.15)  
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Wall-cell dissipation,   

*3u

y



                                                                                            (4.16) 

 is Von-Karman constant equal to 0.42 

 

4.5 DFBI Modeling 

Dynamic Fluid Body Interaction (DFBI) module simulate the motion of a rigid body in 

response to pressure and shear force the fluid exerts. STAR-CCM+ calculates the resultant 

force and moment acting on the body due to all influences, and solves the governing equations 

of rigid body motion to find the new position of the rigid body [28] . A rigid body (defined 

using a 6-DOF Body in STAR-CCM+) can be defined as an object in which the relative 

distance between internal points does not change. Using the standard Cartesian coordinate 

system as a reference frame, it is possible for a rigid body to move (translate) along each of the 

three axes, and to rotate about the axes. 

This commercial code has the advantage to work with free motion enables to control which 

direction of motion will be calculated and which ones to be leave constraints. Present interests 

are to evaluate the sinkage (translation along the z axis) and trim (rotation about the y axis). 

Therefore Z motion and Y rotation are free to calculate and other four terms are kept as frozen. 

The solution processes [47] for sinkage and trim can be summarized as follows: 

a)  The flow around the ship hull with the fluid viscosity, flow turbulence and deformation of 

free surface taking into consideration is computed by the RANSE solver in the usual way 

(ship-fixed). 

b) The normal and shear stresses are integrated over the body surface to obtain the forces and 

moments acting on the body and then the amounts of sinkage and trim needed to balance the 

fluid dynamic forces and moment are evaluated. 

c) The grids of ship are rearranged to take the sinkage and trim into account, and the fluid 

flow is computed again. 

4.6 Solver Setting 

In the implicit unsteady solver the physical time step is selected following the ITTC guideline 

which gives the mathematical formulation given below: 
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0.005 0.01 /t L U                                                                                                          (4.17) 

Where t is the time step, L is the length between perpendicular and U is flow velocity.  

For 6 (Six) DOF solver, the maximum number of iteration is chosen as 5 iteration to compute 

fluid forces, moments, and gravitational forces on a 6-DOF body and moves the vertices of the 

grid according to motion of the body. 

In the stopping criteria, the maximum inner iteration is selected for every 10 iterations to get 

the required solution after every time step. The maximum number of iteration is continued until 

the residuals convergence.
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5 Chapter 5 

Results and Discussions 

Simulations are carried out for four types of mono hull: Wigley hull, Kriso Container Ship 

(KCS) hull, Series 60 hull, and HSVA tanker and for one multihulls: Wigley catamaran hull. 

Simulation results constitute of total resistance coefficient, wave pattern and profile, sinkge, 

and trim are discussed in this chapter.  

5.1 Wigley Hull 

The Wigley hull is most commonly used for ship like form. It is a mathematically defined 

parabolic hull and the underwater hull is described by the equation, 

2 2

2 2

4
1 1

2

B z x
y

H L

  
    

  
                                                                                                     (5.1) 

The x-axis shows forward, y to starboard and z downward. The main particulars of the 

mathematically defined Wigley hull are provided in the Table 5.1. 

Table 5.1: Main Particulars of Wigley Hull 

Particulars Value 

Length (m)  ( )L m  3.0 

Breadth (m)  (m)B  0.3 

Draft (m)  (m)H  0.1875 

Block coefficient 
B

C  0.444 

Mid-ship coefficient 
X

C  0.667 

Wetted surface area coefficient 
S

C  0.661 

Vertical center of gravity  (m)KG  0.17 

Moment of inertia 

/
XX

K B  0.30 

/
YY

K L  0.25 

/
ZZ

K L  0.25 

 

The dimensions of the half of the computational domain (Fig. 5.1) is taken as of 12m long, 6m 

wide, and 3.5 m deep with the total no of cells of 2579745 for the finest grid. The grid is refined 
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by creating additional rectangular block at the free surface indicated by the dark region in order 

to get better resolution of the free surface and this is so done following the ITTC 

recommendation that a minimum of 80 cell numbers per wave length and a maximum of 20 

cell numbers per wave height should be kept at the free surface.  The mesh resolution also 

refined around the hull with high density of mesh. Two more mesh resolutions such as medium 

(1249498 cells) and coarse (599208 cells) are employed in the simulation to carry out the 

convergence study. The mesh structures of the computational domain and the hull are shown 

in Fig. 5.2 and Fig. 5.3 respectively. The resulting mesh is composed principally hexahedral 

cells with trimmed cells next to the surface. The prism boundary layer is applied around the 

ship hull to capture the flow properties with accuracy. 

 

 

 

 

 

 

 

 

 

 

Fig. 5.1: Computational Domain of Wigley Hull 
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Fig. 5.2: Mesh structure for flow computation domain  
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Fig. 5.3: Grid distribution on the surface of Wigley hull 

 

 

Total Resistance Coefficient 

The Wigley model is simulated for a wide range of Froude numbers, obtained results of total 

resistance coefficient is shown in Fig. 5.4 with the experimental data [48] and also with the 

results performed by Barros [49]. The total hull resistance increases as the speed (Froude No) 

increases as shown in Fig. 5.3. At the lower Froude no, the frictional resistance dominants and 

at the higher Froude no, 𝐹𝑛 ≥ 0.40 the resistance curve increases rapidly as the wave resistance 

dominates. The curve of the total resistance followed a number of “hump” and “hollow” in the 

curve. The interference effect between the bow and stern transverse wave systems (discussed 

in section 2.6) is the reason for the hump and hollow condition in the resistance curve. First 

hollow occurred at Fn range 0.25-0.28 and 2nd occurred at Fn range 0.34-0.36 and then 

followed by significant hump at the peak at Fn about 0.47. Above the Froude number 0.47, the 

interference transverse bow and stern become less significant while the divergent waves 

become more and more important.  As the ship moves, the energy given to the water by bow 

is carried out laterally and away from the ship and hence the height of each succeeding wave 

of each system decreases with no considerable change in wavelength results in a decrease in 

wave resistance [33].  
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Moreover, with the increasing Froude number, the wetted surface area decreases gives a less 

value in frictional resistance. So, the effect of decreasing value in frictional and wave resistance 

follows a downward trends in resistance curve after the significant resistance value as shown 

in Fig. 5.4. Overall, the resistance coefficient consistency shown in Fig. 5.4 is found in good 

agreement with of those available experimental results and Barros [49] as well.  

The summary of resistance coefficient results with error calculation is given in Table 5.2. The 

relative error is found using this formula: 

|𝐸𝑟𝑟𝑜𝑟| = |
𝑆 − 𝐷

𝐷
| × 100                                                                                                               (5.2) 

S is stand for the simulated computational fluid dynamics (CFD) results and D stands for the 

experimental fluid dynamics (EFD) results. The relative errors found by Barros [49] carried 

out the simulation in OpenFOAM solver are slightly larger than the relative error found by the 

present simulation carried out in STAR-CCM+ solver. 

Fig. 5.4: Comparison of total resistance coefficient for Wigley hull. 
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Table 5.2: Relative error analysis of resistance coefficient for Wigley hull 

Froude 

No 

Speed, 

U (m/s) 

Reynolds 

No, Rn 

310TC   

EFD (D) 

310TC   

CFD (S)  

|𝐸𝑟𝑟𝑜𝑟| 310TC   

 [49] (S) 

|𝐸𝑟𝑟𝑜𝑟| 

0.25 1.356 3.6 × 106 4.61 4.689 1.714 % 4.51 2.169 % 

0.267 1.448 3.8 × 106 4.57 4.602 0.700 % 4.46 2.407 % 

0.289 1.567 4.1 × 106 4.83 4.921 1.884 % 4.69 2.898 % 

0.316 1.714 4.5 × 106 5.21 5.315 2.015 % 4.97 4.606 % 

0.354 1.920 5.1 × 106 5.01 5.047 0.738 % 4.83 3.593 % 

0.408 2.213 5.8 × 106 5.72 5.814 1.643 % 5.49 4.021 % 

 

Sinkage and Trim 

Figure 5.5 shows the comparison of sinkage and trim with the experimental values and 

indicates a good agreement between those two values. The sinkage values are normalized by 

L/100 and due to very small value of trim angle, values are multiplied by 100. A negative value 

of sinkage indicates the downward direction and positive value of trim indicates the bow up. 

0.15 0.20 0.25 0.30 0.35 0.40 0.45

-0.5

-0.4

-0.3

-0.2

-0.1

0.0

1
0
0
 

/L

Froude No, Fn

 Present Simulation

 Experiment [48]

 

(a) Sinkage  
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(b) Trim 

Fig. 5.5: Comparison of sinkage and trim for Wigley hull 
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Pressure Field 

The pressure distribution over the hull surface is shown in Fig. 5.6 for different Froude 

numbers. Pressure is normalized by the 
1

2
𝜌𝑈2 term, where 𝜌 is the fluid density and 𝑈 is the 

free stream velocity.  High pressure gradient is expected at the region where the flow interacts 

with the rapid changing geometry: the bow and stern regions are such geometries. From the 

figure it has been shown that the forward and aft portion of the ship experience larger pressure 

than any other location. The forward of the hull is positioned at the right side in the Fig. 5.6. 

Fn = 0.25 Fn = 0.267 

Fn  = 0.289 Fn = 0.316 

 

Fn = 0.354 

 

Fn = 0.408 

Fig. 5.6: Pressure distribution over the surface of Wigley hull 
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Wave Profile and wave pattern 

The computed wave profiles along the Wigley hull are presented in the Fig. 5.7 and compared 

with the experimental data [48]. Both axes: position and wave height is normalized by the 

length of the hull. The computed wave profiles with the present methodology are well 

compatible with the experimental results at the almost every location along the hull.  
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Fig. 5.7: Wave profile along the Wigley mono hull with experimental results. 

 

At near of the bow of the hull, the wave elevation has its highest value near the bow of the hull 

and immediately behind the hull as expected. At the lower Froude number, there are number 

of crest in the wave profile while it decreases at the higher Froude number as shown in Fig. 

5.7. The pressure increases where wave crests are found and pressure decreases in the trough 
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of the wave profile. For the Wigley hull, the breadth to length (B/L) ratio is 0.1 which is much 

less than the practical hull form and therefore the predicted wave profile is in well agreement 

both in height and profile with the experimental one. It has also been concluded that the 

wavelength is increased with the increased value of Froude number i.e. increment of reference 

speed which is the indication of increase of wave resistance. 

The computed wave contour for the same Froude numbers mentioned above are presented in 

the Fig. 5.8. The ship hull is fixed relative to incoming water flow (water flows in the negative 

x direction i.e. bow to stern direction) and the water creates both diverging waves spread 

outward from the hull and transverse wave following behind the stern of the ship hull. The 

consisting wave pattern is known as the Kelvin wave pattern.  

Fn = 0.25 Fn = 0.316 

  Fn = 0.267 Fn = 0.354 

Fn = 0.289 Fn = 0.408 

Fig. 5.8: Kelvin Wave pattern at different Froude numbers for Wigley hull 
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From the wave pattern it can also be seen that with the increasing Froude number, the wave 

height (Position [Z]) marked by the red color (at the bow location) is increasing. A comparison 

have also been made in Fig. 5.9 with the published numerical results (Tarafder and Khalil [50]) 

carried out by a boundary element method (BEM) for solving a non-linear free surface problem. 

The qualitative comparison is found for the wave pattern at the Froude numbers 0.289 and 

0.316 and hence it can be stated that the present finite volume method (FVM) gives a 

reasonable simulation of wave field. 

Fn = 0.289 (Tarafder and Khalil [50] Fn = 0.316 (Tarafder and Khalil [50] 

Fn = 0.289 (Present Simulation) Fn = 0.316 (Present Simulation) 

 
 

Grid Dependence Test 

In finite volume method, the partial differential equations are solved numerically for RANS 

equations and hence the discretization errors are introduced. Theoretically it is said that to 

minimize that errors, the number of cells by discretization are increased. However, in numerical 

analysis to study the errors and uncertainties, grid independence study must be done. In this 

case, three simulations were performed by keeping all the parameters same except the grid 

refinement. A systematic grid refinement ratio, 𝑟 = √2 was applied to the three directions in 

the computational domain. The grid properties with the cell no and the grid solutions are shown 

in Table 5.3. 

Fig. 5.9: Kelvin Wave pattern comparison for Wigley 

hull 
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Table 5.3: Grid properties for 𝑪𝑻, 𝑪𝑭, and 𝑪𝑾 

Grid No Cell No 𝑟 = ℎ𝑖 ℎ1⁄  𝐶𝑇 × 103 𝐶𝐹 × 103 𝐶𝑊 × 103 

Grid 1 (Fine) 2579745 1.000 4.583 3.569 1.013 

Grid 2 (Medium) 1249498 1.414 4.602 3.592 1.010 

Grid 3 (Coarse) 599208 2.000 4.753 3.756 0.998 

 

The simulated results for Wigley hull at the three grids are given in Table 5.4 with the relative 

solution changes (𝜀), relative error (𝐸%𝐷) and EFD (D) value is also given for the comparison.  

Table 5.4: Grid convergence study of 𝑪𝑻, 𝑪𝑭, and 𝑪𝑾 for Wigley hull 

Grid 𝑆1 (Grid 1) 𝑆2 (Grid 2) 𝑆3 (Grid 3) EFD Data 

𝐶𝑇 × 103 4.583 4.602 4.753 4.57 

𝐸%𝐷 -0.28 -0.70 -4.00 

𝜀% -0.40 -3.28 ---  

𝐶𝐹 × 103 3.569 3.592 3.756 3.55 

𝐸%𝐷 -0.53 -1.18 -5.80 

𝜀% -0.64 -4.56 ---  

𝐶𝑊 × 103 1.013 1.010 0.998 1.02 

𝐸%𝐷 0.68 0.98 2.15 

𝜀% 0.29 1.18 ---  

 

From Table 5.4 it has been shown that the relative errors are in acceptable range. Especially 

for the finest grid solution: 0.28%, 0.53%, and 0.68% for the total, frictional and wave 

resistance coefficients which are very low. Also, the relative solution change between Grid 1 

and Grid 2 is less than change between Grid 2 and Grid 3 that indicates the state of convergence.   

Solution changes between medium-fine and coarse-medium can be written as  

𝜀21 = 𝑆2 − 𝑆1                                                                                                                      (5.3) 

𝜀32 = 𝑆3 − 𝑆2                                                                                                                      (5.4) 

𝑆1, 𝑆2, 𝑎𝑛𝑑 𝑆3 are the solutions of fine, medium, and coarse mesh refinement. Convergence 

ratio defined as 

Convergence ratio, 𝑅𝐺 =
𝜀21

𝜀32
=

𝑆2−𝑆1

𝑆3−𝑆2
                                                                                   (5.5) 

Three convergence conditions are possible: 
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i. Monotonic convergence: 0 < 𝑅𝐺 < 1 

ii. Oscillatory convergence: 𝑅𝐺 < 0 

iii. Divergence: 𝑅𝐺 > 1 

As the calculation procedure for all the solution parameters is same, only the calculation of 

total resistance coefficient (𝐶𝑇) is presented here. The convergence ratio: 

𝑅𝐺 =
𝜀21

𝜀32
=

𝑆2 − 𝑆1

𝑆3 − 𝑆2
=

(4.602 − 4.583) × 10−3

(4.753 − 4.602) × 10−3
= 0.12 

The value of convergence ratio, 𝑅𝐺  indicates that this the monotonic convergence condition i.e. 

the simulated result has been converged. And, also the simulated result is independent of the 

grid refinement. For monotonic convergence, generalized Richardson Extrapolation (RE) [40] 

is used to evaluate the numerical uncertainties which has been discussed in Chapter 3.  

The 1st order RE estimate 𝛿𝑅𝐸, the order of accuracy 𝑝𝐺, and correction factor 𝐶𝐺  are given as 

follows: 

𝑝𝐺 =
ln (𝜀32 𝜀21)⁄

ln (𝑟)
=

ln (0.151 0.019)⁄

ln (√2)
= 5.98 

𝛿𝑅𝐸 =
𝜀21

𝑟𝑝𝐺 − 1
= 2.74 × 10−6 

𝐶𝐺 =
𝑟𝑝𝐺 − 1

𝑟𝑝𝑒𝑎𝑠𝑡 − 1
= 6.95 

For 𝐶𝐺 sufficiently less than or greater than 1 (one) and lacking confidence, the grid uncertainty 

𝑈𝐺 is determined as follows: 

𝑈𝐺 = |𝐶𝐺𝛿𝑅𝐸| + |(1 − 𝐶𝐺)𝛿𝑅𝐸| 

                        = (19.04 × 10−6) + (16.3 × 10−6) 

           = 35.34 × 10−6 = 0.77% 𝑆1 

The numerical uncertainty is found by, 𝑈𝑆𝑁 = √𝑈𝐺
2 + 𝑈𝐼

2 

Where 𝑈𝐼 is the iterative uncertainty and assumed to be negligible in comparison to the grid 

uncertainty (𝑈𝐼 ≪ 𝑈𝐺) such that 𝑈𝑆𝑁 = 𝑈𝐺 

The convergence ratio 𝑅𝐺 , order of accuracy 𝑝𝐺 , correction factor 𝐶𝐺 , and the numerical 

uncertainty 𝑈𝑆𝑁 for all the resistance coefficients following the above procedure are given in 

Table 5.5.  
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Table 5.5: Verification of 𝑪𝑻, 𝑪𝑭, and 𝑪𝑾 for Wigley hull 

Study 𝑅𝐺 𝑝𝐺  𝐶𝐺 𝑈𝑆𝑁 

𝐶𝑇 0.12 5.98 6.95 0.77 % 𝑆1 

𝐶𝐹 0.14 5.66 6.13 1.18 % 𝑆1 

𝐶𝑊 0.25 4.00 3.00 0.50 % 𝑆1 

From Table 5.5 it has been shown that grid convergence ratio 𝑅𝐺  for every resistance 

coefficient falls between 0 to 1, which is the indication of monotonic convergence [43], i.e., 

results are grid independent. For total resistance and frictional resistance coefficients, the order 

of accuracy 𝑝𝐺 was found of larger value which in result lead to get higher numerical 

uncertainties. However, in case of wave resistance coefficient, 𝐶𝑊 the numerical uncertainty 

was found lower than the other two values. All the uncertainties values are indicated as the 

percentage of the finest grid solution 𝑆1. 

Validation 

For the validation purpose, the finest grid solution 𝑆1 is used to compare with the experimental 

data. The comparison error can be calculated as: 

𝐸 = 𝑆1 − 𝐷 

                                             = 4.583 × 10−3 − 4.57 × 10−3 

                                       = 0.013 × 10−3 = 0.28% 𝐷 

The symbol D is denoted for the experimental fluid dynamics (EFD) data. The validation 

uncertainty is calculated from  

𝑈𝑉 = √𝑈𝑆𝑁
2+𝑈𝐷

2 

𝑈𝐷 is the data uncertainty equal to 2.5% D [33].  

𝑈𝑉 = √(0.773% 𝐷)2+(2.5% 𝐷)2 

= 2.62% 𝐷                              

The absolute value of comparison error is calculated as  

|𝐸|%𝐷 = |
𝑆1 − 𝐷

𝐷
| × 100 

 

The comparison error 𝐸, validation uncertainty 𝑈𝑉, experimental data uncertainty 𝑈𝐷 for all 

solution parameters are tabulated in Table 5.5. All the calculated values are shown as 

percentage of the EFD (D) value. 𝑆1is the simulation result for finest grid. 
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Table 5.6: Validation of 𝑪𝑻, 𝑪𝑭, and 𝑪𝑾 for Wigley hull 

Study |𝐸|% 𝑈𝑉% 𝑈𝐷% 

𝐶𝑇 0.28 %D 2.62 %D 2.5 %D 

𝐶𝐹 0.53 %D 2.77 %D 2.5 %D 

𝐶𝑊 0.68 %D 2.55 %D 2.5% D 
 

From Table 5.6 it has been observed that the relative errors for three cases are less than the 

validation uncertainties. According to Wilson [44], this condition (|𝐸|<𝑈𝑉) implies that the 

results are well validated. For three cases the validation uncertainties are generated with 

reasonable lower value. However, among them for the frictional resistance coefficient, the 

validation uncertainty shows a little bit higher value than the total and pressure resistance 

coefficient. Overall it is concluded that numerical results are nicely validated with the 

experimental results.   

Grid Dependence and Validation of a point variable: Wave elevation, z  

Wave profile along the hull for three grids: coarse, medium, and fine are shown in the Fig.  

5.10. Experimental data [48] of wave profile is also shown for the comparison. Normalized 

value of maximum wave height is used for the verification and validation study 

 

In the above figure, the wave heights are at different location along the hull surface at the free 

surface are normalized by the length of the hull. The overall pattern of wave profile for three 

grid sizes with the experimental data have satisfactory pattern. The numerical results of 

maximum normalized wave height,  
max

z  for Wigley hull at the three grids are given in Table 

5.7 with the relative change, 𝜀 and EFD value is also given for the comparison. The 

convergence ratio 𝑅𝐺 , order of accuracy 𝑝𝐺 , correction factor 𝐶𝐺 , and the numerical uncertainty 

𝑈𝑆𝑁 are given in Table 5.8. 
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Fig. 5.10: Grid dependency on wave profile of Wigley hull 
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Table 5.7: Grid convergence study of wave profile for Wigley hull 

Grid/Study 𝑆1 (Grid 1) 𝑆2 (Grid 2) 𝑆3 (Grid 2) EFD (D) Data 

max
z  0.3767 0.3764 0.3505 0.3580 

𝜀  -0.08 % -6.8 % 
 

Table 5.8: Verification and validation of wave profile for Wigley hull 

Study 𝑅𝐺  𝑝𝐺 𝑈𝑆𝑁 |𝐸|% 𝑈𝑉% 𝑈𝐷% 

max
z  0.012 12.86 0.16 % 𝑆3 2.09 %D 2.51 %D 2.5 %D 

 

From Table 5.8, the order of accuracy was found with very high value from the typical 

theoretical order of accuracy. This is because of the changes of solutions of the point variable 

tends to value of zero. The validation was done with the solution of Grid 3 and it was found 

that the relative error is less than the validation uncertainty, i.e., the wave profile is validated 

against the experimental data. 

5.2 KCS Hull 

KRISO container ship (KCS) is usually chosen as a benchmark for flow computations.  

Principal particulars of the model ship and full scale are tabulated below in Table 5.9. 

Table 5.9: Main particulars of KCS hull form 

Principal particulars Full Scale Model 

Length between perpendiculars ( )PPL m  230.0 7.2786 

Length of waterline ( )WLL m  232.5 7.3577 

Maximum beam of waterline ( )WLB m  32.2 1.0190 

Depth ( )D m  19.0 0.6013 

Draft ( )T m  10.8 0.3418 

Displacement volume 3( )m  52030 1.6490 

Wetted surface area 2( )WS m  9424 9.4379 

Block coefficient  B PP WLC L B T    0.6505 0.6505 

 

Moment of inertia 

XXK B  0.40 0.4 

YY PPK L  0.25 0.25 

ZZ PPK L  0.25 0.25 
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The origin of the coordinate system is located in an undisturbed free surface at midship so that 

the undisturbed incident flow appears to be a streaming flow in the positive direction. The z 

axis is vertically upward and the y axis extends to portside. The size of one-half of the 

computational domain (Fig. 5.11) is -2.97 L<x<1.97 L, 0<y<2.47 L, -1.0 L<z<0.17 L and is 

taken into account due to vertical plane symmetry that leads to reduce the number of element 

and to require less time to converge the problem. The KCS hull is firstly analyzed at the fixed 

condition to get the calm water resistance and then allowed to rotate about y-axis to calculate 

sinkage and trim. The mesh discretized view of computational domain and the hull are shown 

in Fig. 5.12 and Fig. 5.13. Three different mesh distributions are applied which are categorized 

as fine (1057126 cells), medium (531014 cells), and coarse (303224 cells) mesh. 
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Fig. 5.11: Computational Domain of KCS hull 

Fig. 5.12: Mesh structure of flow computation domain 
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Resistance Coefficient 

Total resistance coefficient (𝐶𝑇) is calculated using the equation 2.79, where the total 

resistance (𝑅𝑇) is obtained by averaging the resistance values over a certain period of physical 

time starting from the convergence state of the performed simulation. Such convergence history 

of resistances are shown in Appendix D. At the Fn = 0.26, the simulation runs almost for 64 

sec and the convergence state (the solution reached at the steady sate) of the result is found 

approximately at 30 sec and therefore the resistance value is extracted by averaging the values 

from 30 sec to 64 sec as shown in Fig. 5.14. It is observed that at the very beginning of 

time, the fluctuation rate is very high. But after elapsing certain period of time, fluctuating 

becomes very low and then solution is being converged. Among them frictional resistance is 

converged very fast. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5.13: Grid Distribution on the KCS hull 
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Fig. 5.14: Convergence history of Resistance of KCS hull at Fn = 0.26 
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The Predicted total resistance coefficients are shown in Fig. 5.15 with the experimental results. 

The total hull resistance increases as the speed (Froude No) increases. The curve of the total 

resistance followed a number of “hump” and “hollow” in the curve. First hollow occurred at 

Fn range 0.20-0.28 and then followed by significant hump at the peak at Fn about 0.52. As 

known the characteristic of the hollow and hump phenomena occurred in the resistance trend 

is due to the interference between the bow and stern transverse waves. Above the Froude 

number 0.52, the interference transverse bow and stern become less significant while the 

divergent waves become more and more important.  As the ship moves, the energy given to the 

water by bow is carried out laterally and away from the ship and hence the height of each 

succeeding wave of each system decreases with no considerable change in wavelength results 

in a decrease in wave resistance and so decreases in total resistance. From the figure it has been 

shown at the very low Froude number the deviation between CFD and EFD [51] results is high 

but the discrepancy between these two is low at relative higher Froude number. The overall 

pattern of the resistance coefficient is quite satisfactory with the experimental results. The 

relative error between CFD and EFD values are given in Table 5.10. 
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Fig. 5.15: Comparison of total resistance coefficients of KCS hull. 
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Table 5.10: Relative error analysis of total resistance coefficient for KCS hull 

Froude No Speed, V 

(m/s) 

Reynolds No, 

Rn 

310TC   

(EFD)(S) 

310TC   

(CFD)(D) 

|𝐸𝑟𝑟𝑜𝑟| 

0.108 0.915 5.23 × 106 3.796 3.357 11.56 % 

0.152 1.281 7.33 × 106 3.641 3.269 10.22 % 

0.195 1.647 9.42 × 106 3.475 3.265 6.04 % 

0.227 1.922 1.10 × 106 3.467 3.344 3.55 % 

0.260 2.196 1.26 × 106 3.711 3.635 2.00 % 

0.282 2.379 1.36 × 106 4.501 4.376 2.77 % 

 

Sinkage and Trim 

To investigate the dynamic behavior (in this case sinkage and trim), the KCS hull is simulated 

at free condition. Hull model is allowed to translate in the vertical direction and to rotate about 

the transverse axis. In the DFBI modeling, the release and the ramp time are chosen 1.0 sec 

and 5.0 sec. Release time gives some times to the fluid flow to be initialized before the motion 

calculation begins. Force and moments are applied on the hull body at the Ramp time and at 

this time solutions are carried out by reducing the oscillation.  In Fig. 5.16 (a), the sinkage of 

KCS increases at the downward direction with the increasing Froude numbers. Fig. 5.16 (b) 

shows the changing trend of trim angle at different Froude numbers. The negative value of trim 

angle means trim by bow.  Both the sinkage and trim values are compared with the 

experimental results [52] and a good consistency is found between those.  
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Fig. 5.16: Comparison of (a) Sinkage and (b) Trim for KCS hull 
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The relative error analysis for sinkage and trim are given in Table 5.11. The present 

Computational Fluid Dynamics (CFD) results indicated by simulation (S) are compared with 

the Experimental Fluid Dynamics (EFD) indicated by data (D) for 6 (Six) Froude numbers.  

|𝐸𝑟𝑟𝑜𝑟| = |
𝑆 − 𝐷

𝐷
| × 100 

At the low Froude number the relative error is quite high for both sinkage and trim predictions. 

At the low speed, the Reynolds number is lower than the higher speed. It increases the laminar 

boundary layer and turbulent boundary layer thickness. Moreover, the mesh resolution can be 

a reason for this high deviation and prediction can be improved by applying a higher mesh 

resolution. The deviation margin decreases with increase in Froude number, Fn. With the 

increasing Froude numbers especially at the Froude numbers 0.260 and 0.282, the differences 

are only 4.02% and 0.12% to the experimental data for Sinkage and differences are 1.77% and 

1.26% to the experiments for the Trim values.     

Table 5.11: Relative error analysis of Sinkage and Trim for KCS hull 

Froude 

No 

Speed, 

U(m/s) 

Sinkage, 

CFD (S) 

Sinkage, 

EFD (D) 

|𝐸𝑟𝑟𝑜𝑟| Trim,  

CFD (S) 

Trim,  

EFD (D) 

|𝐸𝑟𝑟𝑜𝑟| 

0.108 0.915 -0.23 -0.09 --- -0.03 -0.017 76.5% 

0.152 1.281 -0.43 -0.275 56.4% -0.057 -0.053 7.55% 

0.195 1.647 -0.70 -0.599 16.86% -0.086 -0.097 11.3% 

0.227 1.922 -1.01 -0.944 6.99% -0.137 -0.127 7.87% 

0.260 2.196 -1.45 -1.394 4.02% -0.172 -0.169 1.77% 

0.282 2.379 -1.70 -1.702 0.12% -0.157 -0.159 1.26% 

 

 

Pressure Field 

The pressure distribution over the hull surface is shown in Fig. 5.17 for different Froude 

numbers. Pressure is normalized by the 
1

2
𝜌𝑈2 term, where 𝜌 is the fluid density and 𝑈 is the 

free stream velocity. In the calm water condition, maximum pressure met at the bow of the ship 

hull. Moreover the appendage section: rudder experiences a high pressure as shown in the 

figure. 
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Fn = 0.108 Fn = 0.152 

Fn = 0.195 Fn = 0.227 

Fn = 0.260 Fn = 0.282 

 

 

Wave Field 

Figure 5.18 shows the generated Kelvin wave pattern (wave contour) for different Froude 

number. The wave pattern consists of the transverse and diverging waves as shown in figure. 

There are very less disturbance of wave surface at the low Froude number, however, the 

Fig. 5.17: Pressure distribution over the surface of Wigley hull 
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disturbance of wave surface augments with the increasing Froude numbers and therefore the 

wave making region spread outward from the bow and the ship itself as well.  

Fn = 0.108 Fn = 0.152 

Fn = 0.195 Fn = 0.227 

Fn = 0.26 Fn = 0.282 

Fig. 5.18: Kelvin Wave pattern for KCS hull at different Froude numbers 
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Simulated Kelvin wave pattern at Froude no of 0.26 is compared with the experimental wave 

pattern as shown in the Fig. 5.19. A good agreement in wave height and position of the wake 

are found and this achievallity assure the accuracy of CFD analysis around the hull form.   

 

 

The wave profile around the KCS at Fn = 0.26 is plotted against the experimental data and 

shown in Fig. 5.20. Wave height and location along the hull both are normalized by the length 

of the hull. In the RANS method, the highest wave crest occurs at the stern and bow region of 

the ship hull. The bow region is placed at the x/L=0.5 and the stern is placed at the x/L=-0.5. 

Therefore, the highest wave crests are found at those locations as shown in the figure.  
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Fig. 5.20: Wave profile along the KCS hull 

Fig. 5.19: Comparison of Kelvin wave pattern of KCS hull between CFD (bottom) and EFD (top) 
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Fig. 5.21: Transverse wave cut of KCS hull 

 

Transverse wave cut is found at the intersection of the wave pattern at the distance of 1.098m 

from the center line of the ship. This distance is also normalized by the length between 

perpendiculars of the ship. Transverse wave cut analysis is presented in Fig. 5.21 with the 

available experimental data. A good agreement is found in this wave cut result.  

Grid Dependence Test 

Total three solutions with the uniform mesh refinement to the three directions of the whole 

domain equal to 𝑟 = √2 recommended by ITTC [53] are used in this present study. Total 

calculation procedures has already been carried out in the Wigley hull section 5.1.  The grid 

properties with the corresponding numerical results are given in Table 5.12. 

Table 5.12: Grid properties for 𝑪𝑻, Sinkage, and Trim 

Grid No Cell No 𝑟 = ℎ𝑖 ℎ1⁄  𝐶𝑇 × 103 Sinkage, (m) Trim, (deg) 

Grid 1 1057126 1.000 3.650 -0.0143 -0.170 

Grid 2 531014 1.414 3.635 -0.0145 -0.172 

Grid 3 303224 2.000 3.590 -0.0149 -0.182 

 

The simulated results for KCS hull at the three grids are given in Table 5.13 with the relative 

solution changes (𝜀) , relative error (𝐸%𝐷) and EFD (D) is also given for the comparison. The 

convergence ratio 𝑅𝐺 , order of accuracy 𝑝𝐺 , correction factor 𝐶𝐺 , and the numerical uncertainty 

𝑈𝑆𝑁 are given in Table 5.14. 
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 Table 5.13: Grid convergence study for 𝑪𝑻, Sinkage, and trim for KCS hull 

 

 

 

 

 

 

 

 

 

Table 5.13 shows that the relative solution change between Grid 1 and Grid 2 is less than 

change between Grid 2 and Grid 3 that indicates the state of convergence. 

Table 5.14: Verification of 𝑪𝑻, Sinkage, and trim for KCS hull 

Study 𝑅𝐺 𝑝𝐺  𝐶𝐺 𝑈𝑆𝑁 

𝐶𝑇 0.33 3.17 2.00 0.6 % 𝑆1 

𝜎 (𝑚) 0.50 2.00 1.00 1.4 % 𝑆1 

𝜏 (deg) 0.20 4.64 4.00 2.0 % 𝑆1 

 

From the Table 5.14 it has been shown that the convergence ratio 𝑅𝐺  for all the solutions falls 

in this limit: 0<𝑅𝐺<1. That indicates the monotonic convergence and the further carried out 

results are grid independent. For monotonic convergence, the errors and numerical 

uncertainties are calculated using generalized Richardson Extrapolation (RE). The order of 

accuracy for resistance and trim are higher than the theoretical order of accuracy of 2 that is 

perfectly attainable for the sinkage.  

Validation 

From the verification study, numerical uncertainties are obtained. The comparison error 𝐸, 

validation uncertainty 𝑈𝑉, experimental data uncertainty 𝑈𝐷 are calculated for validation 

process which is explained in details in Stern [43]. These values are shown in Table 5.15. 

Grid 𝑆1 (Grid 1) 𝑆2 (Grid 2) 𝑆3 (Grid 3) EFD (D) Data  

𝐶𝑇 × 103 3.650 3.635 3.590 3.711 

𝐸%𝐷 1.64 -2.14 -3.26 

𝜀% 0.41 1.24 ---  

𝜎 (𝑚) × 102 -1.43 -1.45 -1.49 -1.394 

𝐸%𝐷 2.58 4.02 6.88 

𝜀% -1.40 -2.76 ---  

𝜃 (deg) -0.170 -0.172 -0.182 -0.169 

𝐸%𝐷 0.59 1.77 7.69 

𝜀% -1.17 -5.81 ---  
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Where the symbol D is denoted for the EFD data. All the calculated values are shown as 

percentage of the EFD value. The absolute value of comparison error is calculated as 

|𝐸|%𝐷 = |
𝑆 − 𝐷

𝐷
| × 100 

S is the simulation result for finest grid. 

Table 5.15: Validation of 𝑪𝑻, Sinkage, and trim for KCS hull 

Study |𝐸|% 𝑈𝑉% 𝑈𝐷% 

𝐶𝑇 1.62 %D 2.67 %D 2.5 %D 

𝜎 (𝑚) 2.58 %D 6.47 %D 2.5 %D 

𝜏 (deg) 0.59 %D 5.52 %D 2.5% D 

 

From Table 5.15 it has been observed that the comparison error for three cases are less than the 

validation uncertainties. According to Wilson [44], this condition (|𝐸|<𝑈𝑉) implies that the 

results are well validated. However, for the sinkage and trim, the results are validated with the 

higher validation uncertainty level 6.47%D and 5.52%D respectively. 

Figure 5.22 shows a grid dependency study of wave profile along the hull for three number of 

mesh arrangement namely Grid 1 (Finest), Grid 2 (Medium), and Grid 3 (Coarse) respectively 

and a satisfactory agreement is found with the experiment results of Kim et al. (2001) [51].  
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Fig. 5.22: Grid dependency study of wave profile for KCS hull 
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5.3 Series 60 Hull 

Series 60 hull is extensively used in numerical and experimental studies. Several towing tank 

tests were carried to investigate the hydrodynamic behaviors which are very crucial to know at 

the initial stage of design. The principal particulars of Series hull are given in Table 5.16 and 

its surface mesh is shown in Fig. 5.23.  

Table 5.16: Main Particulars of Series 60 Hull 

 

 

 

 

 

 

 

 

 

Particulars Value 

Length (m)  ( )L m  1.0 

Breadth (m)  (m)B  0.1333 

Draft (m)  (m)H  0.0533 

Block coefficient 
B

C  0.6 

Mid-ship coefficient 
X

C  0.977 

Wetted surface area coefficient 
S

C  0.710 

Vertical center of gravity  (m)KG  0.051 

 

Moment of inertia 

/
XX

K B  0.40 

/
YY

K L  0.25 

/
ZZ

K L  0.25 

 

Fig. 5.23: Grid distribution on the surface of Series 60 hull 
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The size of one-half of the computational domain is  −2.6 𝐿 < 𝑥 < 1.5 𝐿, 0< 𝑦 < 2.0 𝐿, 

−1.5 𝐿 < 𝑧 < 0.2 𝐿 and is taken into account due to vertical plane symmetry as shown in Fig. 

5.24. Numerical simulation is carried with the model of L = 1 m in a computational domain 

has the dimension of  4.1𝑚 × 2𝑚 × 1.7𝑚. A prism layer hexahedral mesh is applied and 

generates 300065 control volume cells within the domain. 

 

Fig. 5.24: Mesh structure for flow computation of Series 60 hull 
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Fig. 5.25: Comparison of total resistance coefficient of Series 60 hull 
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The total resistance coefficients for various Froude numbers ranging from Fn = 0.20 to 0.72 

are computed and compared with the experimental results [54] and the results obtained by 

Karim and Naz [55] as shown in Fig. 5.25. A fairly good agreement is found among these 

results. The curve of the total resistance followed a number of “hump” and “hollow” in the 

curve. First hollow occurred at Fn range 0.2-0.25 and 2nd occurred at Fn range 0.31-0.35 and 

then followed by significant hump at the peak at Fn about 0.46. Further from this Froude 

number, the resistance curve goes downward due to the less transverse wave interference 

between bow and stern waves and increase in wetted surface area as well. 

The comparison between the obtained simulation results and experimental results [56] for wave 

profile along the hull are shown in Fig. 5.26.  The highest wave crest is found at the bow 

location where maximum pressure is subjected for every Froude number. The series 60 hull 

has a large B/L ratio equal to 0.133 and hence wave profile has some discrepancy with the 

experimental data as shown in figure. 
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Fig. 5.26: Wave profile along the Series 60 hull at different Froude numbers 
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Figure 5.27 shows the wave contour at different Froude numbers. At the low Froude numbers 

0.22 and 0.25, the disturbance of the wave surface is low and hence wave making region 

spreads less from the hull body. On the contrary, with the increasing Froude number, the 

surface wave disturbance increases and wave waking region spreads more from the bow region.  

Fn = 0.22 Fn = 0.25 

Fn = 0.28 Fn = 0.30 

Fn = 0.32 Fn = 0.35 

Fig. 5.27: Kelvin Wave pattern for Series 60 hull at different Froude numbers 

 

Furthermore, for Froude numbers 0.25 and 0.32 the simulated wave patterns are compared with 

the numerical analysis by Huang [57]. A very good agreement has been found between these 

two results as shown in Fig. 5.28, where the left side figures are for Huang [57] and the right 

side figures are for present study. 
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Fig. 5.28: Comparison of wave pattern between Huang[57] (Left) and present study (Right) 

 

Grid Dependence and Validation 

The mathematical procedures and detailed calculation of V&V study have already been 

discussed in the case of Wigley and KCS hulls. The tabulated results of total resistance 

coefficient are presented here for the Series 60 hull.  

Table 5.17: Grid properties for 𝑪𝑻 at Fn = 0.30 

Grid No Cell No 𝑟 = ℎ𝑖 ℎ1⁄  𝐶𝑇 × 103 

Grid 1 (Finest) 587743 1.000 5.97 

Grid 2 (Medium) 300065 1.414 6.05 

Grid 3 (Coarse) 178391 2.000 6.45 

 

Table 5.18: Grid convergence study for 𝑪𝑻 Series 60 hull 

Grid 𝑆1 (Grid 1) 𝑆2 (Grid 2) 𝑆3 (Grid 2) EFD Data 

𝐶𝑇 × 103 5.97 6.05 6.45 5.94 

𝜀  1.34 % 6.62 % 
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Table 5.19: Verification of 𝑪𝑻 for Series 60 hull 

Study 𝑅𝐺  𝑝𝐺 𝐶𝐺 𝑈𝑆𝑁 

𝐶𝑇 0.2 4.64 4.00 2.34 % 𝑆1 

 

Table 5.20: Validation of 𝑪𝑻 for Series 60 hull 

Study |𝐸|% 𝑈𝑉% 𝑈𝐷% 

𝐶𝑇 0.51 %D 3.43 %D 2.5 %D 

 

Table 5.18 shows that the relative solution change between Grid 1 and Grid 2 is less than 

change between Grid 2 and Grid 3 that indicates the state of convergence. Table 5.20 presents 

that the relative is less than the validation uncertainties and this condition (|𝐸|<𝑈𝑉) implies 

that the results are well validated. 

Figure 5.29 presents the grid dependency study on the wave profile at Froude number 0.30. It 

has been shown that there is a good consistency level among the grid results and has a 

compatibility with the experimental result as well. 
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Fig. 5.29: Grid dependency on wave profile for Series 60 hull 
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5.4 HSVA Tanker 

The HSVA tanker is a limiting case with its high value of block coefficient and low range of 

Froude numbers. The principal particulars of HSVA Tanker are given in Table 5.21 and its 

surface mesh is shown in Fig. 5.30. 

Table 5.21: Main Particulars of HSVA 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The origin of the coordinate system is located in an undisturbed free surface at midship so that 

the undisturbed incident flow appears to be a streaming flow in the positive direction. The z 

axis is vertically upward and the y axis extends to portside. The size of one-half of the 

computational domain shown in Fig. 5.31 is −𝟐. 𝟓 𝑳 < 𝒙 < 𝟏. 𝟓 𝑳, 0< 𝒚 < 𝟐𝑳, −𝟏. 𝟓 𝑳 < 𝒛 <

Particulars Value 

𝐿 (𝑚)  5.00 

𝐵 (𝑚) 0.7575 

𝐻 (𝑚) 0.2805 

𝐶𝐵 0.8503 

𝐶𝑆 = 𝑆 𝐿(2𝐻 + 𝐵)⁄  0.8815 

∇ (𝑚3) 0.9034 

𝑆(𝑚2) 5.8113 

Fig. 5.30: Surface mesh on the HSVA Tanker 
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𝟎. 𝟑𝑳 and is taken into account due to vertical plane symmetry that leads to reduce the number 

of element and to require less time to converge the problem. The mesh discretization view of 

the computational domain is shown in Fig. 5.32. 

 

Fig. 5.31: Computational domain of HSVA Tanker 

 

 

Fig. 5.32: Mesh structure for flow computation of HSVA Tanker 
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The numerical analysis is carried out for Froude numbers ranging 0.13-0.19 and computed total 

resistance coefficients are compared with the experimental results (Collatz [58]) as shown in 

Fig. 33. Simulated resistance coefficients are over predicted than the experimental but the 

overall trend has a good compatibility with the experiment. 

0.12 0.13 0.14 0.15 0.16 0.17 0.18 0.19

4.1

4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

5.0

T
o

ta
l 
R

e
s
is

ta
n

c
e
 C

o
e
ff

ic
ie

n
t,

 C
T
 x

 1
0

3

Froude No, Fn

 Present Simulation

 Exp. (Collatz, 1976) [58]

 

 

-0.50 -0.25 0.00 0.25 0.50

-0.004

-0.002

0.000

0.002

0.004

0.006

0.008

-0.50 -0.25 0.00 0.25 0.50

-0.006

-0.004

-0.002

0.000

0.002

0.004

0.006

0.008

0.010

0.012

-0.50 -0.25 0.00 0.25 0.50

-0.008

-0.006

-0.004

-0.002

0.000

0.002

0.004

0.006

0.008

0.010

0.012

0.014

0.016

-0.50 -0.25 0.00 0.25 0.50

-0.012

-0.010

-0.008

-0.006

-0.004

-0.002

0.000

0.002

0.004

0.006

0.008

0.010

0.012

0.014

0.016

0.018

0.020

z
/L

x/L

 Present Simulation

         Fn = 0.13

z
/L

x/L

 Present Simulation

         Fn = 0.15

z
/L

x/L

 Present Simulation

         Fn = 0.17

z
/L

x/L

 Present Simulation

         Fn = 0.19

 

Fig. 5.34: Wave profile along the HSVA hull at different Froude numbers 

Fig. 5.33: Comparison of total resistance coefficient for HSVA tanker 
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Figure 5.34 shows the wave profile around the HSVA tanker at the Froude numbers 0.13, 0.15, 

017 and 0.19. Only the results of the present analysis are presented here. From the figure it has 

been shown that the wave profiles are quite similar to each other as the Froude numbers are 

low and much closed to each other. However, the maximum wave height increases at the 

forward bow position (x/L=0.5) with the increasing Froude numbers. 

5.5 Catamaran Hull 

The catamaran hull is composed of two identical Wigley mono hulls and has the hull separation 

to length ratio (s/L) is 0.4. Each mono hull is 3m in length, 0.3m in breadth and 0.1875m in 

draft. The size of one-half of the computational domain is −3.5 𝐿 < 𝑥 < 1.5 𝐿, 0< 𝑦 < 1.67 𝐿, 

−1.0 𝐿 < 𝑧 < 0.33 𝐿 and is discretized by 2957198 number of hexahedral cells as given in 

Fig. 5.35. 

 

Fig. 5.35: Computational domain of the wigley catamaran hull 
 

For the catamaran hull shown in Fig. 5.36 special care is taken at separation of the hulls where 

the highly complex flow likely to be generated. This is done by creating another rectangular 

volumetric block with stronger mesh refinement and at the free surface mesh refinement is also 

taken as refined mesh. The simulation results are obtained on a laptop consisting Intel Core i5 

1.8 GHz and 8.0 GB RAM and a total solver CPU time 36 Hours is needed to complete the 

entire simulation. 
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Fig. 5.36: Volume mesh with refinement at the hull separation and wake region 
 

Wigley catamaran hull is simulated at various Froude numbers ranging from 0.2 to 0.75. The 

wave-making resistance of the catamaran hull is shown in Fig. 5.37 and exhibits broadly similar 

trends to those of the published monohull results as well as the experiment of Insel and Molland 

[22] and numerical results of Tarafder and Suzuki [24].  At the low Froude number, catamaran 

hull has a larger wetted surface area as the ship model in low speed and consequently viscous 

resistance greatly affects in the total resistance. With the increasing Froude numbers the wave 

resistance become dominants in the total resistance.  
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Fig. 5.37: Wave resistance coefficient comparison of Wigley catamaran hull 
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The ‘Hump’ and ‘Hollow’ in the wave resistance curve as shown in Fig. 5.38 are occurred due 

to the wave interference effect. Hump occurs when wave resistance arises drastically due to the 

coincidence of crest/trough of bow and stern transverse waves and the Hollow occurs when 

wave resistance falls significantly due to the coincidence of crest of bow and trough of stern 

waves. A significant peak value of wave resistance is found at Froude no around 0.5, above 

this Froude no, the divergent waves become more and more dominant and the height of each 

wave systems decrease with no considerable change in wavelength (i.e. less interference effect 

of transverse bow and stern waves). Therefore, the wave resistance decreases after reaching its 

highest value and would eventually die out.  

The Kelvin-wave contours at Froude numbers 0.35, 0.40, 0.50 and 0.60 are shown in Fig. 5.38. 

From the figure it has been shown that the effect of wave interference between the hulls is 

trivial due to large separation ration s/L=0.4 and the pattern is likely to be similar as the mono 

hull. However, at the smaller value of separation (s) to length (L) ratio, the transverse wave 

becomes dominant over the divergent wave [23]. When this s/L ratio value becomes extremely 

smallest, the wave interference between hulls becomes so larger and the dominant transverse 

waves are circulated from the outer side of the hulls. 

Fn = 0.35 Fn = 0.45 

Fn = 0.50 Fn = 0.60 

Fig. 5.38: Kelvin Wave pattern at different Froude numbers of Wigley catamaran (s/L= 0.4) 
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Figure 5.39 presents the wave profile for outer and inner side of a catamaran hull of s/L=0.4 

for four Froude numbers 0.35, 0.45, 0.50, and 0.60 respectively. The difference in magnitude 

between the inner and outer wave elevation of the catamaran hull is low due to higher s/L=0.4 

that leads to trivial wave interference. At the bow side the wave height of inner profile is 

slightly greater than that of the outer wave profile for every Froude number. This is so because 

the effect of the wave interference even though in small scale. 
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Fig. 5.39: Wave profile along the Wigley catamaran hull (s/L= 0.4) 

 

Figure 5.40 shows the pressure distribution on the surface of catamaran hull. Pressure is 

normalized by the 
1

2
𝜌𝑈2 term, where 𝜌 is the fluid density and 𝑈 is the free stream velocity.  

High pressure gradient is expected at the region where the flow interacts with the rapid 

changing geometry: the bow and stern regions are such geometries. From the figure it has been 

shown that the forward and aft portion of the ship experience larger pressure. 
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Fn = 0.35 Fn = 0.45 

Fn = 0.50 Fn = 0.60 

 

 

 

Fig. 5.40: Pressure distribution on the surface of Catamaran hull 
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Chapter 6 

Conclusions 

In present study, the turbulent flows around Wigley, KCS, Series 60, HSVA Tanker and a 

catamaran hull are investigated numerically using a commercial CFD code STAR-CCM+. The 

k- turbulence model in connection with SIMPLE algorithm is chosen to extract the velocity 

and pressure fields. The following conclusions can be drawn from the analysis: 

a) The standard k- turbulence model can be adopted as powerful tool to analyze the ship 

flow (resistance, sinkage and trim) except for the case where flow separations occur. 

b) The diverging waves radiating from the bow and stern are well predicted and look very 

similar to the wave pattern in deep water (Kelvin wave pattern). 

c) As expected the finer are the grids, the better is the accuracy at a cost of longer 

computation time. Reducing the grid size provides better representation of the bow and 

aft of the ship model. However, it increases the computation time drastically, and 

sometimes the CPU may not be able to compute the huge amount of data because of 

memory deficiency. Several grid refinement studies are performed, and the optimum 

grid size are chosen for resistance calculations. 

d) The magnitude of the wave elevation of the inner side of the catamaran hull is slightly 

higher than that of the outer side at the first crest of the bow. This difference is mainly 

due to the wave-interference effects. 

e) In general, the predictions are fairly good with experiment results for the increasing 

Froude numbers. 
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Appendix A 

Derivation of Turbulent Kinetic Energy, k  

The derivation of turbulent kinetic energy is deduced following Kumar [18] based on the book 

by Tennekes and Lumley [60].  The continuity and momentum equations for unsteady, 

incompressible flow neglecting the body force terms [25]: 
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Applying Reynolds decomposition and multiply Equation (A.2) by u  
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Taking the time average, 
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Now simplify the above Equation (A.6) one by one applying some properties given below: 
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Now rearrange all the term and Equation (A.6) becomes 
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Apply the property: 

21

2

u u
u

x x

 


 
                                                                                                                    (A.15) 

And Equation (A.14) becomes 
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where, 
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and, 

2 2 2 2 2 2 2 2 2
2 2 2

2 2 2 2 2 2

1 1 1

2 2 2
u u u

u u u u u u
u

x y z x y z x y z
  

              
        
        

 
         
                      

 

  (A.18) 

So finally Equation (A.16) looks, 
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Similarly y and z component become when multiply by v  and w  respectively, 

2 2 2 2 2 3 2

21 1 1 1 1

2 2 2 2 2

v v v v v v v u v v v w
u v w u v v v w

t x y z x y z x y z

                 
             

         

    
       

    

 
 

                        

2 2 2 2 2 2
2 2 2

2 2 2

1 1 1

1 2 2 2
v v v

p v v v
v

y x y z x y z
 



          
      
      

 
        
                  

 

  (A.20) 

2 2 2 2 2 2 3

21 1 1 1 1

2 2 2 2 2

w w w w w w w u w v w w
u v w u w v w w

t x y z x y z x y z

                 
             

         

    
       

    

 
 

                     

2 2 2 2 2 2
2 2 2

2 2 2

1 1 1

1 2 2 2
w w w

p w w w
w

z x y z x y z
 



          
      
      

 
        
                  

 

  (A.21) 

Adding Equations (A.19), (A.20), and (A.21) and using the definition of turbulent kinetic 

energy: 

 2 2 21

2
k u v w                                                                                                             (A.22) 

The equation for turbulent kinetic energy stands: 



Appendix A: Derivation of Turbulent Kinetic Energy, k 

 

III 

 

k k k k
u v v

t x y z

   
  

   
 

2 2 2u u u v v v w w w
u u v u w u v v v w u w v w w

x y z x y z x y z

         
                        
         

 

1 p p p
u v w

x y z

     
     
   

 

3 2 2 2 3 2 2 2 31

2

u u v u w u v v v w u w v w w

x y z x y z x y z

                       
         

          

 

2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2

2 2 2 2 2 2 2 2 2

1 1 1 1 1 1 1 1 1

2 2 2 2 2 2 2 2 2
u u u v v v w w w

x y z x y z x y z


 
                 

         
         

 
 

 

2 2 2 2 2 2 2 2 2

u u u v v v w w w

x y z x y z x y z

                                  
                          

                           

                             (A.23) 

 

In the above Equation, for the left hand side, first term is rate of change of k and second term 

is called transport of k by convection. On the other part, for the right hand side, first term is 

production of k  by interaction of Reynolds stress and mean flow, second term is transport 

due to pressure, third term is transport due to viscous stress, and the last term is called rate of 

dissipation of k   . 

Turbulent Transport and Pressure Diffusion 

Turbulent transport of scalar quantities in a turbulent flow is that of diffusion [61] can be 

written, 
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                                                   (A.24) 

Unfortunately, there is no corresponding straightforward analog for pressure-diffusion term. In 

the absence of definitive experimental data, the pressure-diffusion term has generally been 

grouped with the turbulent-transport term, and the sum assumed to behave as a gradient 

transport process. Masour, Kim and Moin [62] indicate that the term is quite small for simple 

flow. Thus, it is assumed that, 
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Where k  (turbulent Prandtl number) is a closure coefficient.  

The right hand side of Equation (A.23) can be more simplified. For doing that start with the 

last term of right hand side of Equation (A.23) which is actually the dissipation rate of turbulent 

kinetic energy. 
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   (A.29) 

Rearranging all the terms and putting into Equation (A.23), the k  Equation becomes, 
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 (A.31) 

 

Equation (A.31) is the final expression for the turbulent kinetic energy, k . 
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Appendix B 

Numerical Scheme to Predict Body Motion 

The forces and moments acting on the free floating body are obtained from 

the flow around the body; at the same time, the fluid flow is influenced by the motion of the 

body. Therefore, the problem has to be solved in a coupled manner, considering the interaction 

of body and flow. Since the fluid flow has to be solved in an iterative manner due to its 

nonlinearity, the determination of the body motion can also be implemented in a similar way 

to take advantage of the iterative feature of the fluid solver. 

Translational Motion 

The governing equation [30] for the translation of the center of mass is given by 

d

dt m


V F
 (B.1) 

After integrating the forces around the body surfaces, the velocity at the new time step n + 1 is 

predicted using the velocity at the previous time step n first, then corrected for later iterations 

by applying the trapezoidal rule to compute the derivative [35]: 
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When the velocities of the body have been obtained, the position of the body can be 

also determined in a similar way: 
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(B.3) 

The incremental displacement of the rigid body can be computed: 
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Rotational Motion 

The equation of rotation of the body is formulated in the Body Local Coordinate System with 

the origin in the center of mass of the body: 
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The discretized form [35] of Equation (B.5) reads 
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1

i

nI  is computed as follows, 
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The orientation of the body is determined by the tensor T . The easiest approach to 

obtain the new orientation of the unit vector 1

i

nx  is 
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Appendix C 

Residual Convergence 

The satisfaction degree of the discretized equation in each control volume cell is represented 

by the residual. The residual plot is a monitor plot that is automatically created from the active 

residual monitors on semi-log axes when iterating starts. By default, all active residuals are 

displayed in the residual plot. Residual monitor keeps a record for each of the transport 

equations solved in the continua within the simulation. As the solution is time-dependent, the 

convergence occurs within each time-step. The continuity, momentum equations, turbulent 

quantity consisting in the residual are being converged when the difference between current 

and previous iteration results decrease. Following that the equation results are reaching values 

that are changing less and less. 

 

 

 

Fig. C.1: Residual convergence of Wigley hull 

Fig. C.2: Residual convergence of KCS hull 
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Fig. C.3: Residual convergence of Series 60 hull 

Fig. C.4: Residual convergence of HSVA tanker hull 

        Fig. C.5: Residual convergence of Wigley catamaran hull 
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Appendix D 

Time History of Resistance 

Figure D.1 to D.4 shows how the resistance on hull converged towards the steady state solution. 

Among the resistance components, the frictional resistance becomes calm to an approximately 

constant value very quickly while the residual resistance fluctuates around the steady state 

value with reducing amplitude. 
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Fig. D.1: Time history of Total, Residual and Frictional Resistance of Wigley hull 
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Fig. D.2: Time history of Total, Residual and Frictional Resistance of KCS hull 
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Fig. D.3: Time history of Total Resistance of Series 60 hull 
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Fig. D.4: Time history of Total, Residual and Frictional Resistance of Catamaran hull 
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Appendix E 

                              Outline of Simulation Setup 

 

 

 

 

Creating a new Simulation 

 Create a File > Serial > Ok 

Importing the file/geometry 

 File > Import > Import Surface mesh > Choose iges/parasolid/x_t extension file 

 Make sure there are no free edges and non-manifold edges. This is done by expanding 

the part import located in the left side tree bar. 

Geometry > Part > Right click on imported part > Repair Surface > Manage > Ok 

 

Creating the Computational Domain and defined each boundary surface 

 Geometry > Part > New Shape Part > Block > Give the three coordinate values of corner 

1 & 2 (Make sure domain only includes the half body of the hull) 

 Name the block as Domain. Expanded the domain > Surface > Block Surface > Split by 

Patch > Define the six surfaces with preferable name: Inlet, Outlet, Top, Bottom, Side, & 

Symmetry 

 

Subtracting the hull body from the domain 

 Geometry > Operation > New > Boolean > Subtract 

 From opening window select Domain and Hull as input parts and Domain as Target part 

and activate Execute operation upon creation then Ok. 

Assigning Parts to Region 

 Right clicke on the Subtract > Assign parts to Region 

Must be zero 
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Activate the Subtract. In the Assign parts to region dialogue  

 Select Create a region for each part 

 Select Create a boundary for each part surface 

 Select Do not create interface from contacts 

 Apply and Close 

Assigning Boundary Condition at each phase and on the hull surface 

 Expand Region > Expanded Subtract > Expanded Boundaries 

 Select Hull and in the properties select type as Wall, Similarly  

 

 

 

Boundary Type 

Hull Wall 

Inlet Velocity 

Inlet 

Outlet Pressure 

Outlet 

Side Symmetry 

Symmetry Symmetry 

Top Wall 

Bottom Wall 

Generating the Volume mesh 

 Expand Geometry > Right click on Operation > New > Mesh > Automated Mesh 

 Select Subtract from the part 

 Enable meshers: 

 Surface Remeshers 

 Trimmed Cell Mesher 

 Prism Layer Mesher 

 

 

Wall 

Type 
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Global Mesh Setting 

 Expand Geometry > Expand Operation > Expand Automated Mesh > Expand Default 

Controls and select the appropriate value. 

 

Base Size Hull Length / (40-60) 

Target Surface Size 50 

Minimum Surface Size 12.5 

Number of Prism Layers  First Calculate the 1st cell layer 

height from this Calculator.  By 

doubling that get the thickness of 1st 

layer perpendicular next to the solid 

wall. Using the stretching (geometric 

progression) factor (1.5) get the 

thickness of next layer and so on 

until the thickness get closer to the 

minimum surface size. 

Prism Layer Stretching 1.5  

Prism Layer Total Thickness Sum up the thickness of all layers 

Volume growth Rate Default growth rate – Slow 

Surface growth rate - Slow 

Maximum Cell Size 800 

Keep all other setting as default values. 

 Expand Geometry > Expand Operation > Expand Automated Mesh > Custom Control > 

Right click on Custom control > New > Surface Control 

Do the work mentioned below as requirement 

Surface Control Control Value 

Part Surface: 

Hull 

Target Surface Size: Custom 50 

Minimum Surface Size: Custom 25 

Part Surface: 

Domain 

Target Surface Size: Custom 800 

Minimum Surface Size: Custom 800 

Prism Layer: Disable -- 
 

https://www.cfd-online.com/Tools/yplus.php
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For mesh refinement create some rectangular block. 

 Expand Geometry > Right click on part > New shape part > Block 

Small Block around the Hull Set Corner 1 & 2 

Large Block around the Hull Set Corner 1 & 2 

Thin Block around the free Surface position Set Corner 1 & 2 

Thick Block around the free surface position Set Corner 1 & 2 

 

 Expand Geometry > Expand Operation > Expand Automated Mesh > Custom Control 

> Right click on Custom control > New > Volumetric Control 

Do the work mentioned below as requirement 

Volumetric Control Control Value 

Part: Small Block Trimmer: Customize anisotropic size Relative X size: 50 

Relative Y Size: 50 

Relative Z Size: 100 

Part: Large Block Trimmer: Customize anisotropic size Relative X size: 100 

Relative Y Size: 100 

Relative Z Size: 200 

Part: Thin Block Trimmer: Customize anisotropic size Relative X size: 5 

Relative Z Size: 10 

Part: Thick Block Trimmer: Customize anisotropic size Relative X size: 12 

Relative Z Size: 25 
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 Select Mesh > Generate Volume Mesh 

The working process and the final total number of cells display in the output. 

 After completing the volume mesh, right click anywhere in the geometry scene (right 

side) and Apply Representation > Volume Mesh.  

The Volume mesh will be shown in the entire domain. 

 

Physics Modeling 

 Expand Continua > Expand Physics 1 > Right click on Model > Select Models  

 Implicit Unsteady from Time group 

 Eulerian Multiphase from Material group 

 Volume of fluid (VOF) from Eulerian Multiphase Model group 

 Turbulent from Viscous Regime group 

 K-Epsilon Turbulence from Reynolds-Averaged Turbulence group 

 Standard K-Epsilon from K-Epsilon Turbulence Model group 

 High y+ wall treatment from K-Epsilon High y+ wall treatment group 

 Cell Quality Remediation, Gravity, and VOF Wave from Optional group 
 
 
  

 Expand Continua > Expand Physics 1 > Expand Models > Expand Eulerian Multiphase 

> Right click on Eulerian Phases > New > Rename Phase 1 as Water > Expand Water 

> Right click on Model > Select Models > Liquid from Material > Constant Density 

from Equation of State > Close 

Again Expand Water > Expand Model > Expand Liquid (By default it is water) > put 

the values of Density and Dynamic Viscosity in the Material Properties. 

 

 Expand Continua > Expand Physics 1 > Expand Models > Expand Eulerian Multiphase 

> Right click on Eulerian Phases > New > Rename Phase 1 as Air > Expand Air > 

Right click on Model > Select Models > Gas from Material > Constant Density from 

Equation of State > Close 

Again Expand Air > Expand Model > Expand Gas (By default it is Air) > put the values 

of Density and Dynamic Viscosity in the Material Properties. 
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 Expand Continua > Expand Physics 1 > Expand Models > Expand VOF Waves > 

Right click on Waves > New > Flat 

Select Flat VoF Wave 1 and give the values of Current and Wind as same in the accurate 

direction. 

 

 Expand Continua > Expand Physics 1 > Expand Initial Conditions 

 

Condition Properties 

Method Scalar Function 

Pressure Field Function Hydrostatic Pressure of Flat Vof Wave 1 

Velocity Field Function Velocity of Flat Vof Wave 1 

Composite: Water Field Function Volume Fraction of Heavy Fluid of Flat Vof 

Wave 1 

Composite: Air Field Function Volume Fraction of Light Fluid of Flat Vof 

Wave 1 
 

Setting up Damping option to avoid wave reflection from boundaries 

 Expand Region > Expand Subtract > Expand Physics Conditions > VOF wave zone 

option and selected Damping. 

 Expand Physics Value > VOF wave damping length > Put 2 to 3 times of wavelength. 

Setting Boundary condition under the Region 

 Expand Region > Expand Subtract > Expand Boundaries > Inlet > Physics Conditions 

> Velocity Specifications and select method to components 

 Expand Region > Expand Subtract > Expand Boundaries > Inlet > Physics Conditions 

> VOF wave damping boundary option and select method to Yes. 

 Physics Values > Velocity > Selected method to Field Function and select Velocity of 

Flat Vof Wave 1 as Vector function 

 Volume Fraction > Composite > Water > Method to Field Function and Volume 

Fraction of Heavy of Flat Vof Wave 1 as Function 

Similarly for the rest of the boundaries. 

 

 

 



Appendix E: Outline of Simulation Setup 

XIX 

 

Boundary Physics Conditions Method Physics 

Values 

Method Scalar Function 

Outlet Vof Wave Damping 

Boundary Option 

Yes Pressure Field 

Function 

Hydrostatic Pressure 

of Flat Vof Wave 1 

Volume 

Fraction: 

Water 

Field 

Function 
Volume Fraction of 

Water 

Volume 

Fraction: 

Air 

Field 

Function 
Volume Fraction of 

Air 

Side Vof Wave Damping 

Boundary Option 

Yes -- -- -- 

Symmetry Vof Wave Damping 

Boundary Option 

No -- -- -- 

Top Shear Stress 

Specifications 

Slip -- -- -- 

Vof Wave Damping 

Boundary Option 

No -- -- -- 

Bottom Shear Stress 

Specifications 

Slip -- -- -- 

Vof Wave Damping 

Boundary Option 

No -- -- -- 

 

For the hull boundary/Surface kept all the values as Default values. 

Setting Dynamic Fluid Body Interaction (DFBI) model 

DFBI module simulate the free motion in response to the fluid force and moment act on the 

body. 

 Expand Tools > Right click on Motions > Select DFBI Rotation and Translation 

 Expand Regions > Expand Subtract > Expand Physics Values > Motion Specification 

and Select Motion to DFBI Rotation and Translation 
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Assigning the Ship Hull in DFBI module 

 Expand DFBI > Right Click on 6 DOF Bodies > New Body > 3D > Continuum Body > 

Rename the body as Ship 

 Select Ship and in the properties put the values 

 Body Surface: Click on [...] and select all the hull boundary surface (if there are 

more than one) 

 Body Mass: Half of the mass of the hull 

 Release Time: 1 sec 

 Ramp Time: 5 sec 

 Select Free Motion > In the properties activate Z motion and Y rotation. (Calculated 

Sinkage and Trim) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Expand Initial Values > Select Center of mass and put the xyz coordinate > Select 

Moment of Inertia and put Diagonal Components values and also activate Use 

Center of mass 
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Solver Setting 

 Solvers > Implicit Unsteady > Set time step to 0.03 sec 

 6 DOF solver > Maximum number of Iterations equal to 5 

 Segregated Flow > Velocity > Under-Relaxation factor equal to 0.7 

 Segregated Flow > Pressure > Under-Relaxation factor equal to 0.4 

 Segregated VOF > Single-step > Under-Relaxation factor equal to 0.8 

 K-Epsilon Turbulence >  Under-Relaxation factor equal to 0.8 

Stopping Criteria 

 Maximum Inner Iterations equal to 10 and activate the Enabled box. 

 Maximum physical time equal to 200 sec and activate the Enabled box. 

 Deactivate the Enabled box in the maximum steps. 

 Activate the Enabled box in the stop File. 

Creating the Iso Surface 

 Right click on Derived Parts > New > Iso Surface 

 In the part selected only Subtract under the Region, in the scalar field select Volume 

fraction of water and select the iso value equal to 0.5. 

 Create another Iso surface (Rename it as Present Simulation) and in this time select 

all the boundaries associated with the hull body. Select volume fraction of water in the 

scalar field and put 0.5 in the Iso value. 
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Generating the Report 

 Right click on Report > New Report > Force (rename it as Pressure force). Select this pressure 

force and in the properties  

 Set direction to the direction of flow [-1.0, 0.0, 0.0] 

 Set Force option to Pressure 

 Set parts to all the hull boundary surfaces. 

 

 Copy and paste this pressure force twice (One for shear and another for Total Force). For shear 

force just set the force option to shear and for total force set the force option to shear + 

pressure. 

 

 Right click on Report > New Report > 6 DOF Body Orientation (rename it as Trim). Select this 

Trim and in the properties 

 Set Angle Report Option to Rotation Y axis 

 Activate Constrained angle Range 

 Right click on Report > New Report > 6 DOF Body Translation (rename it as Sinkage). Select 

this Sinkage and in the properties 

 Set Direction to [0.0, 0.0, 1.0] 

Making the Wave Contour Scene 

 Right Click on Scene > New Scene > Scalar ( Rename it as Wave) 

 Expand Wave > Expand Displayers > Scalar 1 

 Set Contour Style to Smooth Filled + Lines 

 Set Transform to Symmetry 1 

 Scalar 1 > Parts > Select the Iso Surface as Parts 

 Scalar 1 > Scalar Field > Select Position [Z] as Function 
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 Outline 1 > Deactivate the Outline 

 Outline 1 > Parts > Select all the hull boundary surface plus the iso surface 

 

Plotting the Results 

 Expand Reports > Multi Select Shear and Pressure and Right Click > Create Monitor 

and Plot from Report > Single Plot > Under the Plots rename it as Shear and Pressure 

Force. 

 Reports > Right Click on Total Force > Create Monitor and Plot from Report > Under 

Plot rename it as Total Force. 

 Expand Reports > Multi Select Trim and Sinkage and Right Click > Create Monitor 

and Plot from Report > Single Plot > Under the Plots rename it as Time and Sikage. 

 

Before plotting Wave profile do some necessary steps 

 Tools > Field Function > New > Scalar > User Field Function 1 > Rename as 2x/L  

 Function name to 2x/L 

 Definition to (($$Position[0]*2)/-3) {Normalize the x coordinate by length of 

the hull} 

 Tools > Field Function > New > Scalar > User Field Function 1 > Rename as h/L  

 Function name to h/L 

 (($$Position[2])/3)    { Normalize the wave height by length of the hull} 

 Right click on Plots > New Plot > XY Plot (Rename it as Wave profile along the hull) 

 Rename Title as Wave profile along the hull 

 Parts to New Simulation (Already created in the derived parts as Iso surface) 

 X Type: Data type to scalar and Scalar function to 2x/L 

 Y Type: Data type to scalar and Scalar function to h/L 

Save and Run the Simulation. 

 

 

 



Appendix E: Outline of Simulation Setup 

XXIV 

 

 

 

 


